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Notes on Safety This manual does not constitute a complete catalog of all safety measures required for 
operating the equipment (module, device) in question because special operating conditions 
might require additional measures. However, it does contain notes that must be adhered  
for your own personal safety and to avoid damage to property. These notes are highlighted 
with a warning triangle and different keywords indicating different degrees of danger:

Danger

means that death, severe injury, or substantial damage to property will occur if the 
appropriate safety measures are not taken.

Warning

means that death, severe injury, or substantial damage to property can occur if the 
appropriate safety measures are not taken.

Caution

means that minor injury or damage to property can occur if the appropriate safety measures 
are not taken.

Note

is important information about the project, handling the product, or the part of the 
documentation in question, to which special attention must be paid.

Qualified Personnel

Commissioning and operation of the equipment (module, device) described in this manual 
must be performed by qualified personnel only. As used in the safety notes contained in this 
manual, qualified personnel are those persons who are authorized to commission, release, 
ground, and tag devices, systems, and electrical circuits in accordance with safety 
standards.

Use as Prescribed

The equipment (device, module) must not be used for any other purposes than those 
described in the Catalog and the Technical Description. If it is used together with third-party 
devices and components, these must be recommended or approved by Siemens.

Correct and safe operation of the product requires adequate transportation, storage, 
installation and mounting as well as appropriate use and maintenance.

During operation of electrical equipment, it is unavoidable that certain parts of this 
equipment will carry dangerous voltages. Severe injury or damage to property can occur if 
the appropriate measures are not taken:

• Before making any connections at all, ground the equipment at the PE terminal.

• Hazardous voltages can be present on all switching components connected to the 
power supply.

• Even after the supply voltage has been disconnected, hazardous voltages can still be 
present in the equipment (capacitor storage).

• Equipment with current transformer circuits must not be operated while open.

• The limit values indicated in the manual or the operating instructions must not be 
exceeded; that also applies to testing and commissioning.
Siemens Aktiengesellschaft Document No. E50417-H1076-C111-A4

Disclaimer of liability
Although we have carefully checked the contents of this publication 
for conformity with the hardware and software described, we cannot 
guarantee complete conformity since errors cannot be excluded. 
The information provided in this manual is checked at regular inter-
vals and any corrections which might become necessary are includ-
ed in the next releases. Any suggestions for improvement are 
welcome.

The contents of this manual is subject to change without prior 
notice.
Document version: 03.18.01

Copyright
Copyright  Siemens AG 2006 All Rights Reserved
This document shall not be transmitted or reproduced, nor shall its 
contents be exploited or disclosed to third persons without prior 
written consent from Siemens. Infringements shall entitle to dam-
age claims. All rights reserved, in particular in case of a patent grant 
or utility model registration.
 
Registered Trademarks
SIMEAS Q® is a registered trademark of SIEMENS AG. All other 
product and brand names in this manual may be trademarks, the 
use of which by third persons for their purposes may infringe the 
rights of their respective owners.

http://siemens-russia.com/


Foreword

This manual describes the functions of the SICARO Q Manager V2.30 
software.

This manual is intended SIMEAS Q users.

Scope of validity of 
this manual

This manual is valid for the SICARO Q Manager V2.30 software.

This version is suitable for SIMEAS Q devices of the generation 2 work-
ing with firmware version 2.20

Standards The development of the SICARO Q Manager V2.30 software has been 
executed according to the principles of ISO 9001:2000.

Further
support

For general information and questions regarding licences please contact 
your local Siemens sales partner.

Hotline Questions regarding SICARO Q Manager and SIMEAS Q will be 
answered by our Hotline in Nuremberg:

Siemens AG 
Customer Care Center
Humboldtstr. 59
D-90459 Nuremberg

Telefon+49 (0)180 / 5247000
Fax +49 (0)180 / 5242471
E-Mail ptd.support@siemens.com

Downloadarea Information concerning Power Quality products as well as firmware and 
software downloads are available at our Internet download area:

www.powerquality.de or

www.simeas.com
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Product Overview 1
General 
information

With the SICARO Q Manager, measured data of SIMEAS Q devices can 
be called, archived and analyzed. For data transmission, the SIMEAS Q 
devices are connected with the PC. 

The archived measured data can be further processed directly with 
SICARO PQ. Additionally, the measured data can be exported for pro-
cessing with other programs (e.g. Microsoft Excel).

Functional scope The SICARO Q Manager software enables the following functions:

Setting up of a graphic system structure with the connected SIMEAS Q 
devices.

This system structure simplifies controlling the software during active 
operation.

Parameterizing the measurement settings of each single SIMEAS Q 
device.

How a certain measured variable is to be recorded can be determined for 
each SIMEAS Q device.

Remote control of the data acquisition via a PC.

Transferring measured data

In the process of data transmission, the measured data stored in the 
SIMEAS Q devices are called.

Archiving measured data.

The measured data is stored in an archive. After archiving, the measured 
data can be analyzed with the SICARO PQ software and reports can be 
created. The basis for these reports are standards such as EN 50160 
and IEC/EN 61000-2-2 for the network quality. 

Displaying retrieved measured data

The display of measured data is effected in alphanumeric or graphic 
form.

Automatic, cyclic time setting of all connected devices, to adjust the inte-
grated time module with the PC system time. 
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1 Product Overview
Conversion of stored measured data in a text format (ASCII).

After the conversion the data can be further processed with a suitable 
software such as Microsoft Excel.

Updating device-firmware

Compatibility With the SICARO Q Manager V2.30, you can continue to use existing 
projects as of version V2.12. Data is automatically converted when the 
old project is opened for the first time. A new archive is generated which 
contains the existing measured data. The old data is saved. 
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Setting up the Software 2
Overview See the following for information on the setup of the SICARO Q Manager 

V2.30 software.

Contents 2.1  Software requirements  4

2.2  Hardware requirements  5

2.3  Installation of SICARO Q Manager  6
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2 Setting up the Software
2.1 Software requirements

SICARO Q Manager is a 32-bit-application which is executable under 
the following operating system:

Windows XP Professional including Service Pack 2

The SIMEAS Q PAR software is required to define the device addresses 
as well as the connection parameters (baud rate, modem initialization) of 
the SIMEAS Q devices. It is available on the SICARO Professional CD 
and the SICARO Basic CD. 

If you use SIMEAS Q devices equipped with a PROFIBUS interface, you 
must first set up a PROFIBUS communications processor in the PC and 
configure the PROFIBUS DP network. Subsequently to these two 
preliminary steps, the SICARO Q Manager is able to work with 
PROFIBUS network and the SIMEAS Q devices connected. The COM 
PROFIBUS software is required for configuring the PROFIBUS DP 
network. As a rule, this software is delivered with the DP-5412 runtime 
software or with the SOFTNET DP runtime software. 

You can choose all modems available via the Windows system settings.
4 SICARO Q Manager Manual
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2.2 Hardware requirements
2.2 Hardware requirements

System requirements: 

The computer must comply with the hardware requirements of the 
operating sytem used. 

A serial standard interface (COM1,...) is required if SIMEAS Q 
devices with a RS232 interface (7KG8000-8B.20) or with a RS485 
interface (7KG8000-8C.20) are connected directly to the PC, i.e. with-
out using a modem.

If the connection to the SIMEAS Q devices with RS232 interface 
(7KG8000-8B.20) or with a RS485 interface (7KG8000-8C.20) is real-
ized via a modem, a dial-up modem (Hayes standard) is required on 
the PC side. This modem can be implemented as a plug-in board or 
a desktop unit. 

If the connection to the SIMEAS Q devices is realized via a PROFI-
BUS network, the PC must be upgraded to become a PROFIBUS 
master. For this purpose, one of the following Siemens communica-
tion processor modules must be installed in the PC together with the 
corresponding runtime software:

- CP5412 (A2) with the corresponding DP-5412 runtime software
- CP5411, 5611 with the corresponding SOFTNET DP runtime
  software 
5SICARO Q Manager Manual
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2 Setting up the Software
2.3 Installation of SICARO Q Manager 

You install the SICARO Q Manager software via a setup program. 

Installation of the 
software

Proceed as follows: 

Insert the installation CD into your CD-ROM drive. The installation pro-
cess is started.  

Follow the installation instructions. 

Note:

You require administrator rights for installing the software.

Note:

If the installation process is not started automatically, proceed as follows: 

• Click Start → Run.

• Enter X:\SETUP.EXE, with X designating the letter of your CD-ROM 
drive. 

• Click OK. 
6 SICARO Q Manager Manual
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Software Functions 3
Overview This chapter provides an overview of the functional scope of the

SICARO Q Manager software. 

As the following instructions are sequential, you should proceed step by 
step:

• Create a SICARO Q Manager example project.

• Configure the measurement settings.

• Define the display mode and the way of transmission of measured 
data in the example project.

Contents 3.1  Requirements  9

3.2  Launch SICARO Q Manager  10

3.3  Changing the language  11

3.4  Main window user interface  12

3.5  Creating and editing a project  14

3.6  Specifying the device connections  22
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3 Software Functions
3.19  Starting the data transfer  84

3.20  Stopping the data transfer  86

3.21  Exporting data  87
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3.1 Requirements
3.1 Requirements

Before you start to work with the SICARO Q Manager V2.30 software, 
make sure that the following hardware and software requirements are 
met:

For connecting the devices, the corresponding interfaces must be 
available and configured. 

PROFIBUS
The CP5412 (A2) communications module or, as an alternative, one 
of the CP5411, CP5411 (PCMCIA) or CP5611 communications 
modules including the corresponding driver software (DP5412 or 
SOFTNET) has been installed and configured. PROFIBUS system is 
duly configured (see chapter 3). SIMEAS Q devices equipped with a 
PROFIBUS interface (7KG8000-8A.20) are connected to the 
PROFIBUS. The devices are in the recording mode (LED “BF” does 
NOT light up continuously). 

RS232/RS485 interface
SIMEAS Q devices in the versions with a RS232 interface (7GK8000-
8B.20) or with a RS485 interface (7KG8000-8C.20) which are 
intended for a direct or modem communication are connected to the 
PC via a serial interface by means of a cable or a RS485 bus system. 
The connection settings (transfer rate, device address) in the devices 
have been specified and the devices are in the recording mode (LED 
“BF” does NOT light up continuously). 

RS232/RS485 interface via Modem
If the communication to SIMEAS Q devices with a RS232 interface 
(7GK8000-8B.20) or with a RS485 interface (7KG8000-8C.20) is to 
be performed via a modem, the modem must be set up and 
connected via the Windows system controls on the PC side. On the 
SIMEAS Q side, the modems must be configured to the specific 
requirements (Hayes modem commands) and connected to the 
SIMEAS Q devices. As a preliminary step, however, the connection 
settings (transfer rate, device address, modem initialization string) 
must have been specified in the SIMEAS Q devices by means of the 
SIMEAS Q Parameterization software. Also in this case, the devices 
must be in the recording mode (LED “BF” does NOT light up 
continuously). 

The SICARO Q Manager software has been installed successfully (see 
Chapter 2). 

Your master PC provides enough storage capacity. The storage capacity 
required for this purpose depends on the data volume to be recorded. As 
a rule, 14 bytes are necessary for storing of one measured value. 

Note The PROFIBUS tools only required for SIMEAS Q devices with a 
PROFIBUS interface (7KG8000-8A.20). 
9SICARO Q Manager Manual
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3 Software Functions
3.2 Launch SICARO Q Manager

Launching the
program 

After a successful setup of SICARO Q Manager, start this program as 
follows:

Start the program via the Windows start menu: 
Start → Power Quality → SICARO Q Manager → SICARO Q Manag
er. 

The main window is displayed. First, an empty project named Untitled is 
loaded. You recognize this by:

the project name Untitled in the title bar of the main window and

the graphic display. Here, only the graphic icon of the master station is 
displayed as PC.

Fig3_01.gif

Figure 3-1   Main window of SICARO Q Manager
10 SICARO Q Manager Manual
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3.3 Changing the language
3.3 Changing the language

The user interface of the SICARO Q Manager software is displayed in 
the language in which it was set up.

You can change the language at any time by proceeding as follows:

Select Extras → Language. 

Fig3_02.gif

Figure 3-2   Setting the language

The Language dialogue window is displayed.

Fig3_03.gif

Figure 3-3   Language selection window

Select the desired language English from the drop-down list box. 

Confirm your selection with OK.

Now you have to restart SICARO Q Manager.

Terminate SICARO Q Manager via Project → Close.

Restart SICARO Q Manager. After the restart, the SICARO Q Manager 
software displays menu text, dialogue text etc. in the selected language.
11SICARO Q Manager Manual
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3 Software Functions
3.4 Main window user interface

The user interface of the SICARO Q Manager program complies with 
Windows conventions.

Fig3_04.gif

Figure 3-4   User interface of the SICARO Q Manager program

Titlebar The name of the currently loaded SICARO Q Manager project is 
displayed in the titlebar.

Menubar Access the individual program functions via the menu bar.

Toolbar The icons of the toolbar enable you to execute the mostly required 
program functions:

Create new project

Open project

Save project

Start data transfer

Stop data transfer

Print project 

Titlebar
Menubar
Toolbar

Data Area

Statusbar

Context Menu
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3.4 Main window user interface
Fig3_05.gif

Figure 3-5   Icons of the toolbar functions 

Data area In the data area of the main window, the project is represented as a tree 
structure. The data area serves to execute the following functions:

Creating and editing the system structure of a project. 

Via the system structure

you control the data recording. 

you specify the measurement settings of individual devices, i. e. you 
determine the recording method of individual measured variables.

you open the display window. This window serves to display received 
measuring data during the data transfer.

you call the device status (status of the data recording, memory 
utilization) as well as the identification data (device address, order 
number, manufacturing number) of individual SIMEAS Q devices. 
(Not for SIMEAS Q devices equipped with a 7KG8000-8Ax20 
PROFIBUS interface)

you specify in the SICARO Q Manager program the connection path 
for contacting an individual device.

Context menu Depending on whether you have selected an entry and depending on 
which one you have selected, you can call up context menus with the 
right mouse button. The context menu comprises those program 
functions which are valid for the current selection.

Select a program function from the context menu by left-clicking it.

Statusbar Depending on the processing status, the statusbar displays current 
settings and information:

Move the cursor on a toolbar or menu item to get information about the 
selected function displayed in the statusbar.

In addition to this, the statusbar informs you whether the data transfer is 
currently in progress.

Stop data transfer
Start data transfer

Save

Print

Open
New
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3 Software Functions
3.5 Creating and editing a project

During this procedure you build up a graphic system structure depending 
on the given conditions.

Your overall measuring system consists of several SIMEAS Q devices 
which are installed in different system sections or subsections. The 
system structure enables you to display the entire measurement system 
clearly in a graphic tree structure.

To do this, you can virtually define individual system sections by means 
of nodes. These system sections can be subdivided via additional nodes. 
One or several SIMEAS Q devices shall be allocated, i.e. added to each 
system section. These devices are installed in this system section. The 
designation of the system sections and of the individual SIMEAS Q 
devices enables you to easily and quickly select a certain measuring 
point during the usual data capture and display operation of the SICARO 
Q Manager software. 

After calling the SICARO Q Manager program, the empty project 
Untitled is loaded. This project contains only the master icon to which no 
devices are allocated.

Creating a new 
project 

If a SICARO Q Manager project is already displayed on your screen, you 
will have to create a new project Untitled:

Click on the Project new toolbar button.

Or as an alternative:

Open Project → New.

The Untitled data window is displayed. 

Renaming the 
Master

Assign a unique name to the Master so you can easily identify the project 
e.g. in SICARO PQ. Proceed as follows: 

Right-click the Master and select Rename from the context menu. 
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3.5 Creating and editing a project
DuA013a.tif

Figure 3-6   Renaming the Master

Enter the new name of the Master in the text box.

Confirm your entry with the ENTER key.

The new name is displayed. 

Saving the project Save the newly created project. Any following actions (create/delete 
devices) are thus stored in the archive as messages.

Proceed as follows:

Select Project → Save from the menu bar.
The Save as dialog box is displayed.

Select the desired directory. 

Under File name, enter the desired project name.

Click Save. 

Adding a device To allocate a SIMEAS Q device to a master, proceed as follows:

Select the master icon in the main window. 

Select Add → Device from the context menu.
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Fig3_06.gif

Figure 3-7   Add device dialogue window

A SIMEAS Q device icon (with standard designation) is displayed below 
the master icon. Device 1 is the standard device name. 

The data window now displays the icon of a SIMEAS Q device allocated 
to the master.

Fig3_07.gif

Figure 3-8   Master with 1 device
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Renaming a device How to rename a device:

Select the device which should be renamed.

Select Rename from the context menu.

Fig3_13.gif

Figure 3-9   Rename device (according to the same principle already described 
for the node and the master)

Enter the new name for the device into the text box.

Confirm your entry with the ENTER key.

The new device name is displayed.

Note:

The same principle is used for renaming nodes.
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Adding a node Structure the project by adding one or several nodes. The node does not 
influence the functionality. 

So fügen Sie dem Projekt einen Knoten hinzu:

Select the master icon in the data area. 

Select Add → Node in the context menu.

Fig3_08.gif

Figure 3-10   Adding a node from the context menu

A node is now added to the project structure. 

Fig3_09.gif

Figure 3-11   Project structure including the master and “Node 1”

Use the corresponding context menu if you want to add a subnode or a 
device to an existing node in the project structure.
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Removing a device To remove a device, proceed as follows:

Click on the device which you want to remove and call the context menu.

Fig3_10.gif

Figure 3-12   Remove device dialogue window

Select Delete from the context menu.

The selected device is deleted from the data window.
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Removing a node In order to remove a node, proceed as follows:

Select the node which you want to remove and call the context menu.

Select Delete from the context menu.

The selected node is removed from the data window. 

Fig3_11.gif

Figure 3-13   Remove node dialogue window

Saving the project Save the project to accept the changes. 

In the toolbar, select the Save symbol.

Or:

Select Project → Save from the menu bar.

Exiting the program To exit the SICARO Q Manager program, proceed as follows:

Click Project → Exit.

The program is exited and you return to the Windows user interface. 

Note: 

The devices allocated to the node are deleted, too.

Note:

If the changes have not been saved yet, a corresponding message is out-
put when exiting the program.
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Opening an
existing project

To open an already created project, proceed as follows:

Start the SICARO Q Manager. 

Select Project → Open... from the menu. 

Fig3_12.gif

Figure 3-14   Open file dialogue window

Select the desired folder via the file dialog box and then the project file 
you want to open. Project files have the file attribute *.prj.

Open the project by double-clicking the project file.

Or alternatively:

Select the project file and click Open.

The system structure of the selected project is displayed in the data area.
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3.6 Specifying the device connections

Fig3_15

Figure 3-15   Configure device connection

Important: 
The connection settings specified in this context must be identical with 
the settings of the corresponding device. The connection settings are 
specified in the device by means of the SIMEAS Q PAR software within 
the framework of commissioning.
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Selecting the 
device connection

Click on Configure device connection... in the context menu of the 
device. The Set device connection dialogue window is displayed. 

The displayed window provides the following setting options: 

Fig3_16.gif

Figure 3-16   Set device connection dialogue window

Selecting the 
connection type

The following connection types can be selected from an additional drop-
down list box designated Device connection:

No connection

PROFIBUS DP

Direct connection

Modem connection

Specifying the 
device address

The Device drop-down list box serves to specify the device address by 
selecting a number from the Device address list box (e.g. 2). 

Note: 
According to the selected connection type the design of the dialogue 
window may vary.

Note:
To establish a connection with the device, the specified address has to 
match with the device address, configured with the SIMEAS Q 
Parameterization software.
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3 Software Functions
PROFIBUS DP 
connection type

If you select this connection type, the Board number drop-down list box 
is displayed. This box serves to select the number of the board to which 
you actually connect the SIMEAS Q device. As a rule, only one 
communications processor board is installed in a PC. In this case, the 
board number is 1.

Select your board number and click on OK.

Fig3_17.gif

Figure 3-17   Dialogue window for selecting the desired PC interface- 
PROFIBUS DP option selected from the drop-down list box

Direct connection Select this connection type to connect SIMEAS Q devices with RS232 
(7KG8000-8B.20) or with a RS485 interface (7KG8000-8C.20) directly to 
the PC, i.e. without using a modem. The Interface drop-down list box is 
displayed upon clicking this connection type. Specify the COM interface 
to which this device is connected, e.g. COM2. 

The baud rate drop-down list box serves to specify the transfer rate 
(baud rate), e.g. 115.200 bits/sec. In case of long connection lines, it may 
be possible that this high transfer rate cannot be reached - select a lower 
rate. 

The RS485 - converter reflecting data check box is positioned below 
the baud rate drop-down list box. Check this box if the RS232/RS485 
adapter used reflects received characters, which is the case for some 
RS232/RS485 adapters available on the market. The adapter delivered 
with the RS232/RS485 cable set of the SIMEAS Q Parameterization kit 
actually is a reflecting adapter. Consequently, you check the box if you 
use it. However, the box must not be checked for RS232 connections!

IMPORTANT: 
The specifications performed in this context must correspond to the 
specifications of your individual device. 
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Fig3_18.gif

Figure 3-18   Dialogue window for selecting the desired PC interface - direct 
connection option selected from the drop-down list box

Modem connection Select this option if the corresponding SIMEAS Q device is to be 
connected to the PC via dial-up modems and a telephone network. The 
SICARO Q Manager software uses modems installed under Windows. 
For this reason, all modems installed via the Windows system controls 
are available for the SICARO Q Manager. 

If you select the modem connection option, a new drop-down list box is 
displayed. Select the modem to be used with SICARO Q Manager. Click 
on Configure modem to access directly the modem settings of the Win-
dows system controls. If required, you can perform changes here. 

As a last step, enter the desired Telephone number into the correspond-
ing box. You can also enter additional control characters such as “,” 
(1 sec pause during dial-up waiting for exchange line in case of private 
exchange branches). More detailed information on this subject is pro-
vided in the documentation delivered with your individual modem.

IMPORTANT: 

The modem transfer rate specified in the Windows system controls must 
be identical with the SIMEAS Q transfer rate!
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Fig3_19.gif

Figure 3-19   Dialogue window for selecting the desired PC interface - modem 
connection option selected from the drop-down list box

Note: 
As soon as the connection types of all devices existing in the project have 
been specified, the project must be saved to permanently accept the 
settings performed.

The system structure graphically represents the device connection type 
to the left of the device icon. If this is not the case for a certain device icon, 
this means that the connection settings have not yet been specified and 
the device in question is not yet ready for communication. 

Note: 

The connection to the devices can be checked with the 
Receive identification function (see section 3.7). 
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3.7 Receiving the identification of the SIMEAS Q devices

The SICARO Q Manager software allows you to call and display 
identification data of a connected SIMEAS Q device. 

This function is particularly useful as it provides an overview 
of the features of the connected devices.

Fig3_20.tif

Figure 3-20   Receive identification dialogue box

Procedure Select Receive Identification from the context menu of the 
corresponding device. The related dialogue box is displayed. 

In the dialogue box, click on Receive Identification to display the 
following information on the corresponding device:

Order number

Manufacturing number

Firmware version

Latest calibration date

Device address

Network frequency

Click Close to exit the dialogue window 

Note: 

Receiving the identification is only possible if the connection settings are 
parameterized correctly. 
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.

As soon as you have created a new project and specified the connection 
types of all devices, this function is available for testing the communica-
tion with the individual devices. To do this, execute consecutively the 
Receive identification function for all devices. The overall system is 
ready for communication if the SICARO Q Manager software is able to 
display the identification data of each individual device.

NOTE:

Be aware of the Nominal frequency specified in the SIMEAS Q device. 
If the calibrated and the specified frequency are not identical, SIMEAS Q 
will deliver wrong measuring results! Restart the device after each 
network frequency change (see Chapter 3.9.2). 

NOTE: 

The Receive identification function is not available for SIMEAS Q 
devices equipped with PROFIBUS interfaces!
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3.8 Receiving the device status of a SIMEAS Q device

Receiving device 
status

Access this function via the context menu of the device. The following 
window is displayed when selecting this function:

Fig3_21.gif

Figure 3-21   Device status dialogue window

This dialogue window serves to retrieve information on the measuring 
data recording and the memory allocation of the SIMEAS Q device.

The information is mostly self-explaining. Examples of information 
displayed via this function:

Type of 
measurement

No recording started

Recording started

Start recording from... 

Recording over time interval

Attention:

This function is only available for RS232 devices (7KG8000-8B.20) and 
RS485 devices (7KG8000-8C.20). (For devices equipped with a 
PROFIBUS interface, this function is displayed in gray, which means that 
it is deactivated and cannot be executed.

This function is particularly useful for specifying the cycle time of the 
automatic data transfer (see also Chapter 3.17).
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State of the 
measurement

Recording not started

Recording running

Recording not running

Waiting until time condition is fulfilled

State of measured- 
value buffer

OK

Buffer overflow

Recording capacity Indicates the period for which the storage capacity is still sufficient, i.e. 
the period before a buffer overflow.

Number of possible 
entries

70,000 measured values 
If the SIMEAS Q device only captures measured variables via the 
continuous recording option, the overall measuring data memory can 
be reserved for this purpose. In this case, the storage capacity 
amounts to 70,000 measured values (value plus time stamp).

42000 when the MIN/MAX measured values are on
When detecting MIN/MAX measured values, 42000 values can be 
stored.

During disturbances, additional measured values are detected. Thus, 
the memory is filled much faster and the values stated above are not 
valid.

Number of used 
entries for 
continuous 
measurement

The storage capacity remaining for additional measured values can be 
calculated by comparing the value indicated here with the above-
mentioned storage capacity. In this way, the user can easily find out the 
moment when the data transfer should be activated again. This feature 
is particularly interesting when the data transfer was interrupted for a 
certain time. 

Note: 

The principle objective is to record an uninterrupted measured value 
chain for longer periods in the PC as this is the only method allowing a 
correct network quality analysis over a certain period of time.
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3.9 Specifying measurement settings

The context menu of the devices provides the following functions at the 
Measurement settings menu item:

Fig3_22.gif

Figure 3-22    Measurement Settings context menu

Configure Via this menu item you can access the Measurement settings dialogue 
window for specifying the SIMEAS Q measurement settings. Here you 
can perform the measurement settings of the selected SIMEAS Q device 
according to your requirements. Upon calling the Configure... function, 
the dialogue window displays the settings stored in the PC by that time.

These are:

after you have opened a project, the measurement settings of the device 
which were saved together with the project

after you have executed the function Measurement settings 
→ Receive, the settings stored in the SIMEAS Q device by that time

after you have executed the function Measurement settings → Open, 
the settings which are saved in the settings file (*.SQD) can be selected 
in this dialogue window.

Receive Via this function, the current settings in the SIMEAS Q are called by the 
master. 
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Send Via this function, the settings existing in the PC are sent to a device. You 
have to execute this function to activate new measurement settings. 
Prerequisite: The measurement has been stopped and the measured 
data memory deleted.

Open This function serves to open an individual parameter file. In this way, you 
can use parameter files created by means of SIMEAS Q Parameteriza-
tion also in the SICARO Q Manager software. 

Save Via this function you save individual settings files in the project.

Save as This parameter file can be saved under a individual path and file name 
and can be used for the parameterizing of further devices. That 
guarantees consistent settings of each SIMEAS Q.

Note:

After you have performed certain measurement settings, you will have to 
send them to the respective device.

Having executed this procedure for all devices, you will have to save your 
project again. Only by doing this, it is ensured that the settings in the 
project and in the devices are identical. 

Note this requirement must be met for the SICARO Q Manager software 
to be able to display the correct measured variables, which were actually 
captured, in the individual display windows!
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3.9.1 Configuring measurement settings (overview)

The dialogue window for the parameterization is divided into two areas:

Navigation window (left)

Data window (right)

Fig3_23.gif

Figure 3-23    Measurement settings dialogue window

Navigation window The navigation window is structured like the Windows Explorer. 

The measurement settings in the navigation window are subdivided into 
three groups:

Basic settings

Continuous recording

Recording in events of faults

Each group branches further into the level of data sheets. 

Data window In the data window you see the data sheets you have opened via the 
navigation window. 

Data sheets When creating a new project, the data sheets are pre-allocated with the 
values of the Untitled standard data set. These default measurement 
settings correspond to the respective average and limit values specified 
by the EN 50160 standard (features of the voltage in public power supply 
networks). 

Open the individual data sheets via the navigation window by selecting a 
single entry.
33SICARO Q Manager Manual
E50417-H1076-C111-A4

http://siemens-russia.com/


3 Software Functions
Configure the measurement settings by specifying the settings of the 
data sheets according to your individual requirements.

3.9.2 Specifying basic settings

Before selecting individual measured variables, you must first configure 
some basic settings. 

Basic settings This can be done in the navigation window at Basic settings. The 
following settings and measured variables belong to the basic settings:

Network settings

Nominal frequency of the current supply network (50 or 60 Hz)

Network type (single-phase system, 3 wire network - Delta, 4 wire 
network - Star)

Nominal voltage

Transformer ratio of the primary voltage/current transformers, if the 
measured-values are to be captured in primary values
(application description)

Function of the two relay outputs 
(binary output 1 or binary output 2)

Other settings

Calculation of the Flicker irritability factor in A or P values

Specification of the time base for the acquisition of maximum and 
minimum values

Specification of the period of time for recording measured values

Selection of the save mode 
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Network settings Select Network settings in the navigation window (under Basic set-
tings). The dialogue for the determination of these settings is displayed 
in the data window.

Fig3_24.gif

Figure 3-24     Network settings data sheet

You can change the network data specified at any time and adapt 
SIMEAS Q to other networks (measuring areas).

Select the option buttons of the network data which characterize your 
network.

50 Hz or 60 Hz as power frequency

Single-phase system, 3 wire network - Delta, 4 wire network - Star as 
network type

Note:

Exworks SIMEAS Q is set for measurements in a 4 wire network- Star 
with 50 Hz and 230 V (L - N). 

Warning:

Restart your SIMEAS Q device after each change of the network 
frequency setting.

SIMEAS Q uses different scanning frequencies for 50 and 60 Hz. To 
obtain precise measuring results, the SIMEAS Q should be calibrated at 
the network frequency used later during the measurement. 

The Receive identification function displays the network frequency to 
which the measured-value capturing is being synchronized. 
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The SIMEAS Q device can capture measured values either as 
primary or as secondary values. The measured variables are usually 
scanned at a voltage transformer. Specify the transformer ratio to be 
able to capture primary values. If you want to detect the secondary 
values, deactivate the Transformer option. Also for direct voltage 
measurement, e.g. in the 230 V system, deactivate this option. On the 
input side, the SIMEAS Q can measure voltages in a range from 0 to 
280 V.
If you deactivated Transformer, you must additionally specify the 
nominal voltage. The maximum value which can be specified is 
280 V. At any rate, you must indicate phase-ground voltages. For a 
direct measurement in the 230 V network, the nominal voltage is 
230 V. For a measurement with voltage transformers, the nominal 
voltage is in most cases 100/root 3 (57.74V) or 110/root 3 (63.5 V). 
If the Transformer is activated, the transformer ratio on the primary 
side can be specified in the range from 0.1 to 1000 kV and on the 
secondary side in the range from 0 to 280 V.
Attention: The secondary voltage must always be specified in kV! The 
entry in the nominal voltage field serves as a calculation basis for the 
evaluation with SICARO PQ. 

Like for the voltages, the SIMEAS Q device is also able to capture 
currents in primary or secondary values. The transformer ratio of the 
current transformer must be specified accordingly. 
On the input side, SIMEAS Q can measure currents in a range from 0 
to 6 A. If the Without transformer option is selected, SIMEAS Q 
captures measured values in this range. 
On the primary side, the transformer ratio can be indicated in a range 
from 1 to 100,000 A whereas on the secondary side, it can be 
indicated in a range from 0 to 6 A. The secondary transformer output 
usually is 1 or 5 A. 
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Binary outputs SIMEAS Q is equipped with two binary outputs implemented by means 
of optocoupler relays. The switching information available in this way can 
be used with other devices such as recorders, horns, sensing elements 
or pulse recorders. 

You can allocate predefined functions to the binary outputs indepen-
dently of each other.

Fig3_25.gif

Figure 3-25    Binary output data sheet

Presetting Binary output 1 is preset on SIMEAS Q active and binary output 2 is 
preset on Voltage dip.

In order to alter these settings, proceed as follows:

In the navigation window under basic settings select Binary output 1 or 
Binary output 2. The corresponding data window is opened and the 
present setting of the selected binary output is also selected.

Allocate the desired function from the drop-down list box to the binary 
output. Thereby, the following functions are available: 

SIMEAS Q active With the function SIMEAS Q active you can monitor whether the device 
is switched on (contact open). If the contact breaks off, the device is 
either switched off or disturbed. 
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Active/reactive/
Apparent energy 
export per pulse 
(kVA)

If you allocate one of these functions to the binary output, the SIMEAS Q 
device always releases a short pulse as soon as the energy value 
specified in the input box has been reached and captured by SIMEAS Q. 

In the input box, specify the energy value which must be reached to 
release a pulse. This function is suitable for energy counting. 

Active power input/
output

If you allocate this function to the binary output, the input (open contact) 
or the output (closed contact) of active power will be displayed.

Threshold value 
cos ϕ

If you allocate this function to the binary output, the power factor cos ϕ 
will be monitored. 

Determine a threshold value for the factor. If this factor falls below, the 
contact will close and therefore trigger off an impulse. 
You can use this function as alarm indicator.

Voltage dip If you allocate this function to the binary output, a pulse will be released, 
if a voltage dip occurs at this output. 

A voltage threshold value which was configured during the recording of 
fault is used as threshold value. 

You configure this threshold value as follows:

In the navigation window click on Voltage which is located below 
Recording in the event of faults. The data window is displayed. 
Depending on the type of network, you can select up to three phase 
voltages.

Activate the desired phase voltage. The window Enter Threshold is 
displayed.

Determine the necessary thresholds. Hereby, at least one has to be 
below the nominal voltage. 

Enter a hysteresis as percentage value.

Confirm with OK.

Out of the maximum of five configurable threshold values for the voltage, 
the highest below the nominal voltage is the threshold value for the 
voltage dip. This function is only available if the Recording in event of 
faults for voltage option has been activated (see above). 

You can use this function as an alarm indicator. 

If the detected measured data are to be evaltuated with SICARO PQ 
later, the setting in accordance with the standard which is used for the 
reporting is to be made here.
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Fig3_26.gif

Figure 3-26    Enter Threshold value window

Other 
settings

This option makes available all remaining basic settings for the 
parameterization of SIMEAS Q. 

You select the method of calculation for Flicker irritability factors and 
power calculation as well as the save mode and you define time and 
duration of the recording as well as the measuring interval for the 
extreme-value specification during continuous measuring.
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Presettings The preset values are shown in Figure 3-27.

Fig3_27.gif

Figure 3-27    Basic settings - Other settings data sheet 

To make changes, proceed as follows:

Select Other settings in the navigation window below Basic 
settings. The data sheet (Figure 3-27) is opened in the data window.

Execute the necessary settings. In the following, the meaning of the 
individual possibilities of entering are explained in detail.
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Calculate flicker as Flicker is a measurement of voltage fluctuations of low voltage 
distribution. The term flicker is defined as a fluctuating visual feeling, 
caused by a light stimulus whose light density or spectral distribution 
fluctuates after a while (see IEC 61000-3-3).

Flicker values can be calculated:

through the weighting indicators Pst and Plt 

through the weighting indicators Ast and Alt.

(The abbreviations stand for short term or long term). 

Pst or Plt is a measure for the interference effect.

Ast or Alt is a measure for interference susceptibility.

Select Pst, Plt or Ast, Alt as method of calculation.

Method of power 
calculation

You can choose between either the classical method or the expanded 
method for the calculation of the power in a three-phase system.

Choose the classical method when you measure in a balanced 
system, i. e. in a system in which the connected consumers cause a 
balanced load. Moreover, no harmonic voltages should occur in the 
system. 
This mode is preset.

Choose the expanded calculation method when you measure in an 
unbalanced three-phase system. The harmonics are taken into 
consideration during the power calculation.

Start/End of 
recording and 
period of recording 

Determine from when onwards and for which period of time measured 
data shall be recorded.

Choose directly in order to be able to start with the recording without 
delay after the SIMEAS Q device has been connected to the y stem.

Choose from or from...to and enter afterwards the relevant times in 
order to determine the start of recording and also, if necessary, the 
period of recording.

Note:

P-values are used for the flicker calculation in the standard EN 50160. 
Therefore, these values are preset.
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Time base For the continuous measuring with extreme values (MIN and MAX), 
specify here a time base for the extreme value capture. Within the 
framework of the extreme value capture, SIMEAS Q stores the average 
value together with the highest and lowest measuring value occurring in 
a measuring period (averaging time). Example:

Averaging time 1 min; basic averaging time 1 sec. With the beginning of 
each minute, SIMEAS Q starts capturing the 1-minute average value. 
Basic average values are calculated each second (basic averaging time) 
for this purpose. After the measuring period (averaging time), the 1-
minute average value is calculated from 60 basic average values. The 
maximum (MAX) and the minimum (MIN) basic average value are 
determined additionally. The value triple consists of a minimum, a 
maximum and an average value, is saved after each measuring period 
and can be called via the SICARO Q Manager. The capture of the next 
value triple for the next minute starts. 

The described procedure is identical for each measured variable 
enabling the capture of extreme values by means of SIMEAS Q. 

You can define different time bases for:

Currents and voltages

all other measured values. 

Save mode 
(Overwriting)

This setting serves to specify if the SIMEAS Q functions as a recorder or 
as a sensor for measured variables. 

Overwriting mode 
not activated

If you select No, SIMEAS Q works as a measured-value recorder. This 
setting must be selected if data shall not be called continuously from the 
SIMEAS Q devices but in very short periods.

Warning:

The specification of the recording period by means of the settings is 
intended for using the SIMEAS Q with other systems such as 
programmable logic controllers (PLC). If SIMEAS Q devices are used 
with SICARO Q Manager, you should always click on directly. SICARO 
Q Manager makes available additional functions which can be executed 
via the control of the measured-data recording. 

Note:

The averaging time (parameterized while activating the measured 
variables) should be an integer multiple of the time base.
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3.9 Specifying measurement settings
Advantage Measured values which have not yet been called by the PC are 
intermediately stored in the SIMEAS Q device. Depending on the 
average time specified, SIMEAS Q has in this case stored several 
measured values of a measured variable (measured-value chain). This 
procedure ensures that no measuring data is lost as long as the capacity 
of the measured value memory is sufficient. 

Disadvantage As soon as the capacity of the measured-value memory is exhausted, 
SIMEAS Q is unable to save new measured data until storage capacity 
is released again by means of a master station call. Consequently, 
measured data is lost if the data inquiry does not run for a longer period 
of time or if the scan cycle specified is too long.

Overwriting mode 
activated

With the Yes option, SIMEAS Q functions like a sensor. The recording of 
measured-value chains relating to a measured variable is not of primary 
importance in this context. However, this setting is only useful for 
SIMEAS Q devices equipped with a PROFIBUS interface. Due to the 
high transfer rates enabled in this way, current measured values can be 
called from SIMEAS Q in particularly short time intervals of fractions of 
seconds. By means of programmable control systems, these values can, 
for example, be used for control tasks. 

With the Yes option, each stored measured value of a measured variable 
is updated by a newly detected measured value, i.e. the former value is 
overwritten. Consequently, SIMEAS Q does not store a measured-value 
chain in its memory in this case. There is always only one measured 
value per parameter available in the memory.

Advantage A buffer overflow cannot occur.

Disadvantage To record a measured-value chain, it must be ensured that the master 
calls the measured value before this value is updated. If the master 
station does not call the value in the prescribed time, this value is 
overwritten and the former value is lost, i.e. the measured-value chain 
becomes incomplete also in case of very short interruptions of the 
communication between the master and SIMEAS Q. 

Note:

For SIMEAS Q devices with a RS232 on a RS485 interface. You must 
select No. In this way, all values of a measured variable to be measured 
are stored in the memory. These values are deleted in the memory to 
release storage capacity only by the time when values (measured value 
inc. time stamp) are called by the PC.
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3.9.3 Activating measured variables for continuous measuring

During continuous recording, you determine specific periods for 
recording (averaging times) each selected measured variable (except 
flicker). By means of the average time specified, an average value of the 
individual measured value is determined from the current and voltage 
values measured at the input. This average value is stored continuously 
in the memory together with its time stamp. 

In addition, you can capture extreme values occurring within a measuring 
period (time base). 

Selecting
measured variables 

In order to select measured variables for continuous recording and to 
determine the settings, proceed as follows:

Double-click Continuous recording in the navigation window. A list of 
all measured variables that can be recorded continuously is displayed.

Click on the measured variable to be activated. The data sheet for this 
variable is displayed in the data window.

The data sheets are structured similarly for the individual variables. 

The type and the number of possible measured variables depend on the 
individual network type (see Basic settings). In this way, you can activate 
the measurement separately for each phase (if useful) and, in case of 
power measurement, additionally acquire the sum.

Possible inputs will be explained by means of the harmonics example 
(see Figure 3-28).

Note:

If the data are to be evaluated with SICARO PQ, the averaging time must 
be taken from the standard which is to be used for the evaluation in 
SICARPO PQ.

It is also permissible to set the averaging time to an integer part of the 
standard averaging time; though, this influences the memory require-
ments and the processing speed.

Example:
Averaging time in accordance with the standard: 10 minutes →
settable averaging time: 
10 min, 5 min, 2 min, 1 min, 50 s, 40 s, 30 s, 20 s, 10 s. 
44 SICARO Q Manager Manual
E50417-H1076-C111-A4

http://siemens-russia.com/


3.9 Specifying measurement settings
Fig3_28.gif

Figure 3-28    Continuous recording - Harmonic Voltages data sheet 

To determine or alter settings for a measured variable, proceed as 
follows:

Determine the averaging time via the drop-down list box (possible range_ 
from 1s to 1h). The time refers to all variables activated in this data 
sheet.

Activate the measurement for the desired variable by clicking on Yes or 
Yes, with MIN/MAX. By doing the latter you also acquire the extreme 
values for this variable. 

Note:

The averaging time should be an integer multiple of the time base. The 
averaging time in the calculation algorithm of the Flicker measured 
variable is preset and is not parameterized here. The preset averaging 
times are 10 min. for Flicker short term and 120 min. for Flicker long 
term. 

Note:

You have set consistently the period of time for the acquisition of extreme 
values as time base (see Basic settings) for currents and voltages or for 
all remaining measured variables.
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3 Software Functions
In the harmonic voltages or harmonic currents screen form, you also 
determine the harmonics to be measured (up to the 40th harmonic). 

Select individual harmonics (by clicking)

or 

Click on one of the lower buttons and select all harmonics, all even, all 
odd or none.

Warning:

If you use one of these buttons you will overwrite the present selection.
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3.9.4 Activating measured variables for fault recording

During the event-controlled acquisition of measured data, SIMEAS Q 
calculates a mean value for a settable averaging time for each selected 
measured variable. This mean value is compared with threshold values 
previously specified. Measuring data is recorded if the value exceeds or 
falls again below these threshold values. 

Thereby, time as well as the previous measured value are recorded. In 
this way, information about when certain measured variables left a 
nominal range or when they returned to it, is received. 

Selecting
measured variables 

In order to select measured variables for fault recording and to determine 
the settings, proceed as follows: 

Double-click Recording in event of faults. A list of all variables for fault 
recording is displayed.

Click on the measured variable which is to be activated. The data sheet 
for this variable is displayed in the data window.

The data sheets for the individual variables have a similar structure. 

Type and amount of the possible measured variables depends on the 
chosen type of network (see Basic settings). This way, you can activate 
the recording for each phase (if useful) and acquire in addition the sum 
during the power measurement.

Possible inputs will be explained with the example of harmonics 
(see Figure 3-29).

Fig3_29.gif

Figure 3-29    Definition of threshold value for harmonics
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In order to determine or alter the settings for a measured variable, 
proceed as follows:

Determine an averaging time via the drop-down list box. 
The chosen time is valid for all variables activated in this data sheet.

Activate the measurement for the desired variable by clicking on the 
Measurement active check box. The dialogue for the determination of 
threshold values is displayed (not in the case of harmonics). 

In addition, determine which harmonics are to be measured (up to the 
40th harmonic) in the data sheet for harmonic voltages or harmonic 
currents (see Figure 3-29). 

Click on the harmonic which is to be changed.

The Enter threshold window is displayed. 

Fig3_30.gif

Figure 3-30    Enter Threshold value window

Enter the threshold values and the corresponding unit of measurement 
(selection via the drop-down list box).

Confirm with OK.

Note:

For harmonics, the dialogue for the entering of threshold values is only 
displayed, when you select the harmonics which are to be measured. 
You can select threshold values for each individual harmonic. 

Note:

If you click on a check box again, the measurements of the chosen 
variables or harmonics will be deactivated. The set threshold values 
remain preset and are available again during new activation.

The number of possible threshold values is not the same for all measured 
variables.
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Save the project with Project → Save to accept the changes.

Important:

Only after the project has been stored, the PC recognizes which measu-
red variables it can accept for displaying later! Therefore, this step is 
mandatory and must in no case be forgotten. 
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3.10 Printing the project data

You can print the measurement settings for your project. Proceed as 
follows:

Click on Projekt → Print. 

DuA032.tif

Figure 3-31   Window Print

Select the desired printer and the corresponding printing parameters.

After the printing process has started, you will receive a printout of the 
entire project including all devices and their measurement parameters.
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3.11 Specifying the date and time of day in SIMEAS Q devices

Sending date/time 
of day (Set SIMEAS 
Q clock)

Access this special function via the Commands context menu of the 
SIMEAS Q device concerned or via the master context menu (PC icon). 

The time of day in the SIMEAS Q device should correspond to the actual 
time of day to ensure that SIMEAS Q provides all measured values 
captured with a correct time stamp.

In addition to this, the time of day is particularly important for the time-
dependent control of the SIMEAS Q measured-data recording.

Specifying the time 
of day for all 
SIMEAS Q devices

The master context menu serves to specify the time of day for all SIM-
EAS Q devices. With this function, SICARO Q Manager transmits the 
time of day consecutively to all connected SIMEAS Q devices. By the 
same time, SICARO Q Manager corrects the time difference caused by 
the sequential execution of this function. Afterwards, all SIMEAS Q 
devices connected use the same time of day. As a prerequisite, however, 
it must be ensured that the communication connection to all devices has 
been duly established.

Fig3_33.gif

Figure 3-32   Specifying the date and time of day in SIMEAS Q devices
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Specifying the time 
of day for an 
individual 
SIMEAS Q device

To be able to specify the time of day for an individual device, this function 
is also available via the context menu of the device concerned.

Fig3_34.gif

Figure 3-33   Dialogue window for sending time information
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3.12 Controlling measured data recording

3.12.1 Requirements

The SICARO Q Manager software is set up and the system structure 
has been built up.

The connection settings to the individual devices have been set 
correctly and the connection can be established without problems.

All SIMEAS Q devices are set for the respective measuring tasks.

The system structure and individual measurement settings of the 
SIMEAS Q devices are saved as a project.

The overall communication with all devices can be established 
without problems and the individual devices are in the recording mode 
(2 minutes after power ON or restart). 

3.12.2 SIMEAS Q commands

Via the commands

Start recording

Start recording with start time...

Start recording for period

Stop recording

Stop recording and clear memory

you can control the measured data recording in the SIMEAS Q devices. 
You will find the commands in the context menu of the master and the 
individual SIMEAS Q devices.
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Fig3_35.gif

Figure 3-34   Start recording window

Via the context menu of the master, the commands are sent to all 
devices, which means that measured data records can be started and 
ended synchronously for all devices.

Via the context menu Commands of an individual device, you control the 
recording of this particular SIMEAS Q device.

The commands are:

Start recording

Via this command, the recording is started immediately.

Start recording with start time...

Here, you can determine the start of the recording by stating a certain 
time. After the command has been selected, the following dialogue box 
is displayed:

Fig3_36.gif

Figure 3-35    Start recording from time... window
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Enter here the desired starting time. Make sure that you enter a time in 
the future and that time, month etc. given, are correct.

Confirm the execution of the command with OK. 

If the command can not be carried out, an error message will be 
displayed.

Start recording for period...

Fig3_37.gif

Figure 3-36    Start recording in a period dialogue window

Proceed as described above for the Start recording for period... option, 
but determine the start of recording as well as the end of recording.

Stop recording

Stops the recording immediately.

If the recording has already stopped before, an error message is 
displayed.

Stop recording and clear memory

Stops the recording immediately and deletes data which is perhaps still 
existent.

This function initiates a memory reset. A new recording can only be 
started when this command has been carried out.

Note:

The starting of the recording of SIMEAS Q is only possible, if

the recording is not already in progress

the measured data memory is empty.

For this reason, you should execute the Stop recording and clear 
memory command before each start.

Note:

Via the measurement settings Basic settings/Other settings you can 
also control the recording of measured data. If you want to control the 
recording via commands, you will have to select immediately the setting 
Start of recording from the settings.
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3.13 SIMEAS Q restart - special function 

Restart Access this special function via the Commands context menu of the 
SIMEAS Q device concerned. 

This function serves to initiate a restart of the individual SIMEAS Q 
device. 

This function is not required for normal operation. However, it may be a 
particularly useful tool for laboratory tests. 

A restart actually means to switch a SIMEAS Q device OFF and ON 
again. Consequently, the SIMEAS Q device does not record any 
measuring data and does not react on commands or enquiries for a 
period of two minutes after the execution of this command. During this 
time, the device is in its start-up phase during which it can only be 
contacted via the SIMEAS Q PAR software. 

After this period of two minutes, the device switches to normal operation 
and starts recording measuring data according to the measuring settings 
specified within the framework of parameterization. From now on, it also 
uses the connection parameters specified and can also be contacted via 
the SICARO Q Manager software. 

Fig3_38.gif

Figure 3-37    Restart SIMEAS Q
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3.14 Firmware update

The SIMEAS Q comes with the current firmware from our factory. To acti-
vate new functions or to remove possible errors in the firmware, it is also 
possible to upload a new firmware via the SICARO Q Manager.

To update the device firmware please proceed as follows:

Select via the Context menu of the corresponding device the command 
Commands → Send Firmware.

Fig3_39.gif

Figure 3-38   Send Firmware

Afterwards the windows Send Firmware will open.

Select the Firmware you want to send to the SIMEAS Q by clicking the 
Select... button

Attention:

Uploading a new firmware the measured data memory in the device will 
be deleted
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Fig3_40.gif

Figure 3-39   Send Firmware dialogue window

After you have selected the firmware file, send the new firmware by click-
ing the button Send Firmware to the SIMEAS Q.

Afterwards a windows will open, showing you the current status of the 
data transmission.

Fig3_41.gif

Figure 3-40   Status announcement of the Firmware Update

The end of the firmware update will be signalized with a message. Con-
firm the message with OK.

Attention:

Pleas take care, that the selected file has the extension *.B2. Do not use 
any other type of files for an upgrade, otherwise the processor could be 
destroyed.

In case of any doubt please contact our hotline or visit our internet down-
load area www.powerquality.de to get the latest firmware version.

Note:

The duration of the firmware update process strongly depends on 
selected transfer rate and can be between 30 seconds and 5 minutes.
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Fig3_42.gif

Figure 3-41   Message end of firmware update

Close the dialogue window Send Firmware.

Note:

After successful transmission of the firmware the device will restart auto-
matically and switch into the measurement mode (only the left green LED 
is on) 2 minutes later.

Please note the information of the read-me file concerning the firmware.
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3.15 Time setting

The SICARO Q Manager offers you the possibility to set the time of the 
integrated clock module of all connected SIMEAS Q devices automati-
cally. That guarantees that all connected SIMEAS Q have the same time 
base.

For the configuration of the time-set function two different possibilities are 
provided.

Cyclic time setting 
via the master

That enables a parallel setting for all connected SIMEAS Q. Furthermore 
it is possible to select whether a separate communication should be built 
up for the time set or the time set should be carried out in course of the 
data transfer of measured values.

Please proceed as follows:

Select the master with the left mouse button.

Press the right mouse button and select the function Configure auto-
setting of time ...

Fig3_43.gif

Figure 3-42   Configure auto-setting of time 

The dialogue window Configure automatic send time will open.

Note:

The automatic time setting only works when the data transfer has already 
started.

Note:

This settings will be taken over for all connected SIMEAS Q.
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3.15 Time setting
Fig3_44.gif

Figure 3-43   Configure automatic send time dialogue window

Select the function Actualize device time automatically if you want to 
set the time automatically.

Select the desired period time

minute

hour

day

week 

We recommend the setting 1 days. 

Select whether a separate communication should be built up for the time 
setting or not. 

Confirm your choice with OK. Afterwards your settings will be taken over 
for all connected devices.

To select different settings for each device please proceed as follows.

Note:

Due to the telephone costs we recommend to use this function. In this 
case a time set will be carried out in course of the data transfer of mea-
sured values.
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Cyclic time setting 
for device

With it, it is possible to meet individual settings for connected SIMEAS Q.

Proceed as follows:

Select the device you want to configure.

Press the right mouse button and select the function Configure auto-
setting of time ...

Fig3_46.gif

Figure 3-44   Configure automatic setting of time 

The dialogue window Configure automatic time setting will open.

Fig3_47.gif

Figure 3-45   Configure automatic setting of time dialogue window

Select the function Actualise device time automatically if you want to 
set the time automatically.

Select the desired period time.

minute

hour
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day

week

Select whether a separate communication should be built up for the time 
setting or not.

Fig3_48.gif

Figure 3-46   Example of time setting via device

Confirm your choice with OK. Afterwards your settings will be taken over 
for all connected devices. 

Note:

Due to the telephone costs we recommend to use this function. In this 
case a time set will be carried out in course of the data transfer of mea-
sured values.
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3.16 Archiving of measured data

Overview SICARO Q Manager allows you to archive measured data from the 
SIMEAS Q devices. 

The used archive has the following features: 

Measured data can be archived either continuously or in cyclic 
storage mode. 

The program provides quick access to the measured data in the 
archive. 

The archive can be stored both on the local hard disk and on a 
network computer. A permanent connection to the network computer 
is required, otherwise archiving is automatically terminated. 
We do not recommend using a USB stick. 

The user can view the archive occupancy. 

Relevant parameters for the measurement (e.g. thresholds) can 
equally be archived. 

Operational indications and status messages of SICARO Q Manager 
can be saved. 

SICARO PQ can directly access the archive. For more information, 
see the SICARO PQ documentation.

OSCOP P can access the archive. For more information, see the 
OSCOP P documentation.

Note:

When opening a SIMEAS Q Manager project version 2.1x, the data of all 
measured value files (*.sqv) will be converted after a safety prompt. The 
conversion can take some time depending on the size of the measured 
value files. 

The old files are stored in a backup folder. The name of the backup folder 
is assigned automatically. 

Note:

If the SIMEAS Q Manager cannot access the archive (e.g. in case of an 
interrupted network connection), the data transmission is interrupted. 
The data transmission has to be restarted when the connection is 
reestablished. 
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Continuous archive Unlike the cyclic storage archive, the continuous archive contains all 
data starting from the moment the system was taken into service. It 
requires, however, a sufficiently large memory medium. 

You can split the archive into archive parts and divide them among 
several memory media such as local hard disks or hard disks in the 
Ethernet network. 

You assign a size to each archive part. You can choose one of the 
following options: 

Assign a fixed size (e.g. 200 MB) to the archive part. There must be 
enough free space on the memory medium. 

The archive part may occupy the entire memory space of the storage 
medium minus a safety tolerance (e.g. 100 MB). If the hard disk has 
a capacity of 1000 MB, there are 900 MB remaining for the archive 
part. 

If the archive consists of several archive parts, the measured data are 
located in the active archive part. By default, SICARO Q Manager marks 
the archive part that was created first as the active archive.

When the first archive part is full, SICARO Q Manager automatically 
activates the next archive part. The ascending archive part number is 
relevant in this context. 

Archive in the
cyclic storage 
mode 

In order to activate an archive in the cyclic storage mode, you have to 
configure the archive as follows:

Create several archive parts (at least 2). You can specify any path for 
saving the archive parts, a folder on a local hard disk or a network 
directory. Generally, all folders available in Windows Explorer can be 
selected. Activate the cyclic storage mode in the archive properties.

Assign a size limitation to each archive part. Set the same maximum 
memory size for each archive part. 

The following rule of thumb holds for switching between the archive parts: 
the archive part with the next higher number is activated (counting from 
the presently active archive part). If there is no higher number, the 
archive part with the smallest number is activated. Before activating an 
archive part, all data in it are deleted. 

Note:

All the data contained in the archive part is always cleared before an 
archive part is activated. 
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Example:

In the example shown here, the cyclic storage archive should be able to 
hold at least 200 MB of data in 5 archive parts. You should do the 
following calculation to determine the required memory space:

When switching between the archive parts, the archive part to be 
activated next is always cleared. Therefore, the data have to be stored in 
4 archive parts (5 - 1). Therefore, each archive part must have a size of 
50 MB (200 MB / 4). 

The memory space required must hence have a size of 250 MB (5 x 
50 MB). In this example, the memory space must be larger than the data 
volume by 25%. 

You can reduce this percentage by increasing the number of archive 
parts. 

Example:

The cyclic storage archive should be able to hold at least 200 MB of data 
in 11 archive parts. 

The data should be stored in 10 archive parts (11 - 1). Therefore, each 
archive part must have a size of 20 MB (200 MB / 10). 

The memory space required must hence have a size of 220 MB (11 x 
20 MB). In this case, the memory space must be larger than the data 
volume only by 10%. 

Note:

You should always save the project before accessing the archive (e.g. to 
archive configuration). The archive structure is only updated after the 
project has been saved. 

The archive parts of a device must a minimum size of 10 MB. For two or 
more devices the minimum size of the archive parts will increase. 
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3.16.1 Archive configuration

Creating a new 
archive

When saving a new project, an empty archive consisting of an archive 
part is generated automatically. Additional archive parts can be added to 
the archive. 

Archive
configuration

How to configure the archive: 

• In the SICARO Q Manager select the Project →  Archive 
configuration menu item. The Archive configuration window is 
opened. 

• Select the entry Master in the left half of the window. 
 

archiv_01.tif

Fig. 3-47 Archive configuration window, Master

Create new archive 
part

• Right-click the entry Master and select Create new archive part 
from the context menu. The Create archive folder window opens. 

• Specify the folder where you want to save the archive part. The 
project directory is predefined. 

Note:

The cyclic storage mode requires at least a second archive part whereas 
the continuous archive needs only a single archive part. 
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• Confirm by clicking Save. The new archive part is displayed. 

• Activate cyclic storage archive to work in the cyclic storage mode. 

• Select an archive part in the left half of the window. 
 

archiv_02.tif

Fig. 3-48 Archive configuration window, archive part

The Path field indicates the location where the archive part is saved. 
Click on the … button to the right of the field Path to change the path 
where the archive part is saved (the data are moved to the new location). 

The Status field shows the available memory space. It also shows 
whether the archive part contains data and whether it is active. 

• Select the type of Limitation of size and enter the size. 

Note:

If you use the option Fill archive up to remaining free disk space, it is 
not reasonable to create two archive parts on one memory medium. 
68 SICARO Q Manager Manual
E50417-H1076-C111-A4

http://siemens-russia.com/


3.16 Archiving of measured data
Delete archive part Before deleting the archive part, you have to delete the data in the 
archive. The active archive part can not be deleted/cleared.

• Right-click the archive part you wish to delete. 

• Select the Delete data menu item. 

• Confirm the safety prompt with yes. The content of the archive part is 
deleted. 

• Select the Delete archive part menu item. The archive part is 
deleted. 
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3.16.2 View archive statistic

Overview In the window Archive statistic you see:

The available and the occupied memory of the archive parts. 

The time when the archive is expected to be full. 

The period for which data are available. 

You can also print the archive statistic.

View archive 
statistic

• In the SICARO Q Manager select the Project → Archive statistic 
menu item. The window Archive statistic opens. 

• Select the entry Master in the left half of the window. 
 

archiv_03.tif

Fig. 3-49 Archive statistic window

The right half of the window shows the available memory of the archive 
parts. 

• Select an archive part in the left half of the window. The statistic of the 
archive part is displayed. 
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archiv_04.tif

Fig. 3-50 Archive statistic window, archive part

Printing archive 
statistic

• Click the Print button to print the displayed statistic. 
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3.16.3 Archive messages

Overview In addition to the measured data, messages (operational and status 
messages) occurred during operation of SICARO Q Manager can also 
be stored in the archive. 

The following messages are archived: 

A status message when the time is set in the device. 

A status message is set to 1 the moment data are first read out of the 
device. 

A status message is set to 0 the moment reading the data has been 
finished. 

An operational message when an archive part is created. 

An operational message when an archive part is activated. 

An operational message when an archive part is emptied. 

An operational message when an archive part is moved. 

An operational message when the recording is stopped and the 
memory is cleared.

The operational messages are displayed in the dialog upon device 
selection provided they are relevant for the device.

The status messages are displayed in the dialog upon selection of the 
corresponding element under the device provided they are relevant for 
the device.

Operational message that refer not to a device but to an archive are 
displayed in the dialog upon selection of the Archive status element.

The filter for the message display is set to the current day by default. But 
the filter can be set to any time period. You can also print the presently 
displayed messages. 

Viewing messages • In the SICARO Q Manager select the Project → Archive messages 
menu item. The Status messages window is opened. 

The currently available memory space for the archive parts is displayed 
for the Master (as in the Archive statistic window). 

• Select Archive status in the left half of the window. 
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archiv_05.tif

Fig. 3-51 Status messages, archive status

• Define the period of time for which you wish to view the status 
messages. The messages are listed with their time stamp and they 
can be printed via the Print button. 

• Select a device or a node in the left half of the window. 
 

archiv_06.tif

Fig. 3-52 Status messages, device

• Define the period of time for which you wish to view the status 
messages. The messages relating to device or node are listed with 
their time stamp and they can be printed via the Print button. 
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3.17 Setting the cycle times for the data transfer

Configure 
properties for data 
transfer

Access this function via the context menu of the device. The following 
window is displayed when selecting this function:

Fig3_49.gif

Figure 3-53 Data transfer cycle dialogue window

Start time This box serves to enter the date and the time of day of the cycle start.

Interval The three drop-down list boxes serve to specify in minutes, hours and 
days the time interval in which the data are to be called from the SIMEAS 
Q device. 

Example:

Cycle start 1.9.00 18:00:00

Cycle time: 3 hours

Measuring data is called at the following times:

1. 1.9.00 18:00:00

2. 1.9.00 21:00:00

3. 2.9.00 00:00:00

4. 2.9.00 03:00:00

etc., until the data transfer is finished. 

ATTENTION:

Be aware to specify the cycle to ensure that the data is called before the 
SIMEAS Q device enters into a buffer overflow. Use the Device status 
function to obtain information on the maximum duration of the cycle time.
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3.18 Displaying measured data
3.18 Displaying measured data

Besides the transferring and saving of measured data, displaying them is 
an important function of the software SICARO Q Manager.

The display of measured data is also possible via a different window, the 
display-element window. The display-element window can be shown for 
the master or for each connected and configured SIMEAS Q device. In 
order to show the display-element window, click with the right mouse but-
ton on the graphic system structure of the main window on the device 
whose measured data you want to look at. The context menu from which 
you have to select the Display menu item is displayed.

Fig3_50.gif

Figure 3-54 Displaying measured data

Prerequisites:

The graphic system structure has been built up (Chapter 3.5)

The connection to the individual devices has been set correctly and is 
ready for operation.

The individual SIMEAS Q devices have been set for the intended 
measuring task.

The project was saved.
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The display shows only measured data which was acquired by the 
SIMEAS Q via Continuous recording. Displayed is always the 
measured value of a measured variable, which was acquired last by the 
SIMEAS Q device and retrieved by the software. Here, measured 
variables of all connected SIMEAS Q devices can be shown in the 
display-element window of the master. This gives you, for example, an 
overview of the power consumption at all measuring points at which 
SIMEAS Q devices are installed. In the display-element window of each 
device, only the measured variables of this particular device are shown. 

You display measured values depending on the respective measured 
variable with the following display elements:

the standard display element (moving-coil instrument)
for current, voltage, active energy, reactive energy, apparent energy, 
power factor, symmetry, flicker and harmonic distortion factor THD

Fig3_51.gif

Figure 3-55    Moving-coil instrument

the bar diagram with logarithmic Y-axis-scaling for harmonic voltage and 
current

Warning:

Make sure that the measurement settings parameterized in SIMEAS Q 
and the measurement settings known to the project, are the same. To be 
on the safe side, you should pick up the settings of each SIMEAS Q 
device via the function Measurement settings → Receive before you 
save the project.

Only this prerequisite ensures that the software displays the measured 
data provided by the SIMEAS Q device.
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Fig3_52.gif

Figure 3-56    Bar diagram

the display element for energy values

Fig3_53.gif

Figure 3-57    Device element for energy

The following describes the adding, positioning, setting etc. of a display 
element in a display-element window.

Calling the display To be able to read all parameterized measured values, you have to 
display them visually. SICARO Q Manager has functions which allow the 
setup of individual display-element windows for each SIMEAS Q device 
and the master. 

To set up your display-element window, proceed as follows:

Select the symbol of device 1 in the system structure, e.g. Project_1.

Select Display from the context menu.

The displayed sheet is still empty.
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Create display 
element

For each measurement that you want to display visually, you have to 
create a display element.

Click with the right mouse button on the empty display window.

Fig3_54.gif

Figure 3-58    Empty display sheet

Select Add display element from the context menu.
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Select 
measured variable

The Select devices dialogue window is displayed.

Fig3_55.gif

Figure 3-59    Measured variable dialogue window

All devices whose settings you have entered in the data sheets are listed 
in the menu above.

To specify the display element window of the master, select the 
SIMEAS Q device whose measured variable you want to display from the 
Device drop-down list box.

All parameterized measured variables for device 1 are now listed in the 
dialogue window.

Select Voltage L1-N from the Values drop-down list box.

Confirm all entries with OK.

Now you see the first display element in the display window. 
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3 Software Functions
Fig3_56.gif

Figure 3-60    Display for Device 1

Add 
display element

In order to add further display elements for device 1, proceed as follows: 

Call the context menu.

Select Add display element.

The new display element now covers the first one.

Note:

When you add a new display element, it will cover the previous ones. 
Therefore they have to be arranged in the display-element window.
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Arrange
display elements

This is how you arrange several display elements in your display window:

Fig3_57.gif

Figure 3-61    Display elements not arranged

Call the context menu.

Select Arrange display elements.

All display elements are arranged in the display window. You can also 
move individual elements:

Select the display element that you want to move.

The display element changes its color in the titlebar. It becomes darker.

Click on the active display element and move it across the screen.
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Modifying
size of display 
element

This is how you alter height and width of the display element:

Move the cursor across the boundary lines of the display element.

The cursor changes its image: you see a double-sided arrow.

Click on the boundary line, keep the key pressed and pull the line with the 
mouse into the desired direction.

Deleting display 
element

You can delete any display element from the display element file

Select the display element that you want to delete and call the context 
menu.

Select Delete display element.

You will see that the selected display element is deleted from the display-
element window.

Saving layout In order to keep the arrangement of the display elements, save the 
layout:

Call the context menu of the display-element window.

Select Save layout.
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Changing display 
element
properties

In order to alter the measuring range for a display setting, proceed as 
follows:

Select the display element whose measuring range you want to alter and 
call the context menu.

Select Properties from the context menu.

The Properties dialogue window is displayed.

Fig3_58.gif

Figure 3-62    Properties dialogue window

Enter the measuring range From/To and select from the list the 
corresponding Unit.

Confirm your entries with OK.

You will see that the measuring range of the altered display element 
shows the new settings.
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3.19 Starting the data transfer

The following prerequisites must be met to be able to start the data 
transfer:

The connection to the devices have been parameterized and can be 
established.

The archive has been configured. 

The measuring settings of all SIMEAS Q devices have been specified.

The project was stored with the current measuring settings of the 
individual SIMEAS Q devices.

In addition to this, the measured-data recording in the individual 
SIMEAS Q devices should be activated via commands or via the 
device settings.

In contrast to the measured-data recording, the start and the end of the 
data transfer are always activated simultaneously for all devices of the 
master system:

Click on the Start data transfer icon.

or

Select Data transfer → Start from the menu bar.

The project is stored automatically and the archive is checked.

The data transmission is started. 
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3.19 Starting the data transfer
An example:

The following measurements have been activated in the SIMEAS Q 
device:

Continuous measurement:

Voltage UL1, UL2 and UL3
Averaging time 10 min

Harmonic voltage measured on UL1
Harmonics measured: 3., 5., 7., 9., 11., 13., 15., 17., 19.
Averaging time 10 min

Flicker irritability factor on UL2, UL3 with 10 min fix averaging time

Frequency averaging time 10 min

THD on UL1, UL2 and UL3
Averaging time 10 min

Voltage asymmetry
Averaging time 10 min

These are 20 values with an averaging time of 10 minutes. The 
SIMEAS Q device memory has a capacity of 70,000 measuring data. For 
the above-mentioned example, 70,000/20 = 3,500 measuring periods 
can be compensated. For a 10 min averaging time per measuring period, 
this corresponds to a period of 35,000 min (= about 21 days). 

The continuous measurement is most important for the calculation for the 
compensation time. Measured variables captured in case of a fault hardly 
cause a data recording under normal operating conditions. For the 
calculation of the compensation period, such measuring data can be 
taken into account with a security factor. 
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3.20 Stopping the data transfer

You can interrupt the data transfer between the SIMEAS Q devices and 
the master PC at any time.

Stop the data transfer by clicking the Stop data transfer button. 

As an alternative:

Select Data transfer → Stop from the menu bar. 

The data transfer stop is confirmed by a message displayed in a separate 
window. 
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3.21 Exporting data

To process recorded measured data with an external program (e.g. 
Microsoft Excel), the data have to be exported as an ASCII file. 

Exporting data Before exporting recorded measured data, the data transfer between 
SIMEAS Q and Master PC has to be finished.

Measured data can be exported as follows:

• In the SICARO Q Manager, right-click the device whose measured 
data you want to export. 

• Select Export in the context menu. The Enter time window opens. 

archive_07.tif

Fig. 3-63 Enter time period

• Enter the time period for which you want to export data. 

• Click OK. A window opens where you can select a folder. 

archive_08.tif

Fig. 3-64 File export window

• Enter the path. 

• Click Select. The export is started and its progress displayed. 
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archive_09.tif

Fig. 3-65 Export, progress indicator

The data are saved to the indicated folder in several .txt files. The name 
of the .txt files indicates to which device and to which measured quantity 
the data belong. 
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Display file The exported measured data can be listed by means of a table 
calculation program, preferably Excel.

Open the Excel program.

Open via File → Open the exported SICARO Q Manager file.

Select from Search in the catalogue DATA1. 

Select Text files (..., *.txt,...) from the File type drop-down list box. 

Select the measured-value file, e.g. Device 1 - Harmonic U L1.txt.

Fig3_63.gif

Figure 3-66    Open the measurement file in Excel

Perform your inputs and then click the Open button. 
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The Text Import Wizard window is displayed.

Fig3_64.gif

Figure 3-67   Excel Text Import Wizard, Step 1 

Fig3_65.gif

Figure 3-68   Excel Text Import Wizard, Step 2
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Fig3_66.gif

Figure 3-69    Excel Text Import Wizard, Step 3

Click the Finish button.

The Device 1_UL3_cont. file is displayed as table.

Fig3_67.gif

Figure 3-70    File Device 1_UL3_cont
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Fig3_68.gif

Figure 3-71    SIMEAS Q data in daily response graph
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Quick reference 4
In this part the necessary steps for the configuration of a SIMEAS Q 
project are listed.

Connect the SIMEAS Q with the configuration-PC. 

Define the device address with the configuration software SIMEAS Q 
PAR. See Manual SIMEAS Q Parameterization. 

Define the parameters of the connection with the configuration software 
SIMEAS Q PAR. See Manual SIMEAS Q Parameterization. 

Install the device. 

Connect the device with your evaluation-PC. 

Starting SICARO Q Manager (see Chapter 3.2)

Archive configuration  (see Chapter 3.16)

Creating the project (see Chapter 3.5)

Specifying the device connections (see Chapter 3.6)

Specifying measurement settings (see Chapter 3.9)

Configure automatic time-setting (see Chapter 3.15)

Setting the cycle times for the data transfer (see Chapter 3.17)

Displaying measured data (see Chapter 3.18)

Starting the data transfer (see Chapter 3.19)
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Formulas and Algorithms A
Overview Appendix A contains the formulas and algorithms that are used to calcu-

late the RMS values and the derived measured quantities.

Contents A.1  Requirements  96

A.2  Current and voltage  96

A.3  Nominal frequency  97

A.4  Power  97

A.5  Flicker  105

A.6  Harmonics of the voltages and currents  106

A.7  Energy (only for continuous recording)  107
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A Formulas and Algorithms
A.1 Requirements

The measurement algorithms given below refer to measurements in a 
50 Hz system. For 60 Hz systems, the formulas must be adapted 
accordingly.

For measured quantities that are acquired and calculated both during 
continuous measurement and measurement in the event of a fault, the 
formulas and algorithms are identical. Measured quantities that are only 
relevant to one of the two measuring modes are marked accordingly.

A.2 Current and voltage 

SIMEAS Q digitizes the currents and voltages applied with a sampling 
rate of 6,400 Hz in 50 Hz networks and 7,680 Hz in 60 Hz networks and 
calculates the RMS values from them over half a period. 

Voltage and current values consist of an AC and a DC part. In electrical 
supply systems, the DC component is usually zero and therefore does 
not need to be taken into account.

By definition, the RMS value is the quantity of energy that is converted in 
a purely resistive load.

For voltage and current, the RMS values are calculated as follows:

where

U, Ι RMS values
u, i Measured values for voltage and current
N Number of measured values for 16 periods (here: N = 128 * 16).

UAC
1
N
---- uj

2

j 1=

N

∑
 
 
 
 

= ΙAC
1
N
---- ij

2

j 1=

N

∑
 
 
 
 

=
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A.3 Nominal frequency
A.3 Nominal frequency 

The frequency is always determined at input VP1 of the SIMEAS Q. The 
signal is digitized with sampling frequency fsample, where:

An internal frequency counter measures the sampling rate, i.e. the inter-
nal quartz oscillator determines the accuracy and resolution of the fre-
quency measurement.

A.4 Power 

The power is always calculated for all three phases. Connection of the 
wattmeter is invariable and is defined as follows:

In the case of measurement in a three-wire network, the phase-to-phase 
voltages VP1 - P2 and VP2 - P3 and the currents ΙP1 and ΙP3 are connected to 
the inputs of the SIMEAS Q in a two-wattmeter circuit. Because the volt-
age VP3 - P1 and the current ΙP2 cannot be acquired, no measured quanti-
ties based on them (e.g. harmonic on voltage VP3 - P1) can be acquired. 
Therefore, only the values for the complete system can be acquired for 
the powers.

The device can calculate the power either by the classic or by the 
expanded calculation method. The choice of method depends on the 
conditions in the measuring system.

fsample 128 fnom⋅=

Wattmeter Measured 
quantities

Explanation

W1 P1 ⋅ ΙP1 Phase P1 and current of phase P1

W2 P2 ⋅ ΙP2 Phase P2 and current of phase P2

W3 P3 ⋅ ΙP3 Phase P3 and current of phase P3
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A Formulas and Algorithms
A.4.1 Classic calculation 

Here you will find the classic calculation explained generally and using 
the example of a three-wire system.

The measured quantities Vn and Ιn are the RMS values of the fundamen-
tal and the harmonics that the system determines using a Fast-Fourier 
analysis.

The calculated quantities apparent power S and reactive power Q refer 
exclusively to the fundamental, because the definitions of these quanti-
ties are only valid for the fundamental.

General explanation

Active power

where

u, i Measured values for voltage and current
N Number of measured values, here: N = 128 * 16.

Apparent power

Reactive power

Power factor

P 1
N
---- uj ij⋅

j 1=

N

∑=

S UAC ΙAC⋅=

Q S2 P2–=

Note:

The sign of the reactive power Q is defined by the phase angle between 
the fundamentals of the voltage and current. If the value is < 0, Q is 
also < 0.

PF P
S
----=
98 SICARO Q Manager Manual
E50417-H1076-C111-A4

http://siemens-russia.com/


A.4 Power
Polyphase systems
To be able to calculate the power in a three-wire system by the classic 
method, the following conditions must be fulfilled:

Voltage balance

Load balance

No harmonics.

It is possible to apply either the 2-wattmeter method or the 3-wattmeter 
method for the calculation.

2-wattmeter 
method 

For the 2-wattmeter method, the following relations apply:

Total active power

Total apparent power

Total reactive power  

Power factor

Ptotal PW1 PW2+=

Stotal
3

2
------- UP1 P3– IW1⋅ UP2 P3– IW2⋅+( )⋅=

Qtotal Stotal
2 Ptotal

2–=

Note:

The sign of the total reactive power Qtotal is always zero, because the 
positive sequence component in the 3-wire system is not calculated.

PF
Ptotal
Stotal
--------------=
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3-wattmeter 
method 

With calculation using the 3-wattmeter method in a 4-wire system, you 
obtain:

Total active power

Total apparent power

Total reactive power  

Power factor

Ptotal PW1 PW2 PW3+ +=

Stotal UP1 UP2 UP3+ +( )2 ΙP1 ΙP2 ΙP3+ +( )2⋅=

Qtotal Stotal
2 Ptotal

2–=

Note:

The sign of the total reactive power Qtotal is the same as the sign of the 
angle difference between the angles of the positive sequence compo-
nents of the voltage and current (see also Unbalanced systems, 
Page A-94).

PF
Ptotal
Stotal
--------------=
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A.4 Power
A.4.2 Expanded calculation 

The expanded calculation method is used for power calculation in unbal-
anced networks. 

Unbalanced three-phase systems can be described as 2 symmetrical 
systems with different directions of rotation:

Positive phase-sequence system

Negative phase-sequence system. 

The expanded calculation method is described below using one phase 
and 3-wire systems. After that, the unbalance is calculated in a 3-wire 
system.

Balanced system With the expanded method, the device calculates the characteristic val-
ues of the positive sequence system for apparent power, reactive power 
and phase displacement.

The power calculation for one phase only takes account of the funda-
mental which is indicated in the formulas by the index n = 1. 

Active power

Apparent power

Reactive power

Power factor

Phase displacement

P 1
128
---------- uj ij⋅

j 1=

128

∑=

Sn 1= Un 1= Ιn 1=⋅=

Qn 1= Un 1= Ιn 1=⋅( ) ϕn 1=sin⋅=

PF ϕcos=

ϕn 1= ϕun 1=
ϕin 1=
–=
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In 3-phase systems, the device calculates the active power from the 
sum of the individual measurement results of the wattmeters connected:

2-wattmeter method
Sum of the 2 single-phase measurements. The calculation is equivalent 
to the 2-wattmeter method of the classic calculation (see Page A-91).

3-wattmeter method
Sum of 3 single-phase measurements.

Active power

Apparent power

Reactive power

Power factor

where:

pos = positive sequence component of the 3-wire system.

Unbalanced system Unbalance is calculated only in 4-wire systems for the voltages and cur-
rents of the 3 phases. They are defined as the ratio of the balanced sub-
systems Negative sequence system (SubIndex: neg) to the Positive 
sequence system (SubIndex: pos) multiplied by the factor 100 %.

Voltage

Current

Ptotal PW1 PW2 PW3+ +=

Stotal 3 U⋅ pos Ιpos⋅=

Qtotal Stotal ϕpos U, ϕpos Ι,–( )sin⋅=

PFtotal ϕpos U, ϕpos Ι,–( )cos=

Usymu

Uneg
Upos
------------- 100⋅=

Ιsymu

Ιneg
Ιpos
----------- 100⋅=
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A.4 Power
Positive sequence 
system:

Voltage

From this, the following relation is derived for Uα:

Current Taking the phase angle ϕUI into account, the current values of the posi-
tive sequence system are calculated in a similar way to the voltage val-
ues:

From this, the following relation is derived for Ια:

Uα

Uβ

Uγ

1
3
---

1 e
j2π

3
-------

e
j4π

3
-------

1 e
j4π

3
-------

e
j2π

3
-------

1 1 1

UP1

UP2

UP3

⋅ ⋅

 
 
 
 
 
 
 
 

1
3
---

1 ej 120°⋅ ej 240°⋅

1 ej 240°⋅ ej 120°⋅

1 1 1

UP1

UP2

UP3

⋅ ⋅

 
 
 
 
 
 
 

==

Uα
1
3
--- UP1 ej0o ej0o⋅ ⋅ UP2 e j– 120o ej120o⋅ ⋅ UP3 e j– 240o ej240o⋅ ⋅+ +[ ]⋅

1
3
--- UP1 ej0o⋅ UP2 ej0o⋅ UP3 ej0o⋅+ +[ ]⋅

1
3
--- UP1 0o( )cos j 0o( )sin+( )⋅ UP2 0o( )cos j 0o( )sin+( )⋅ UP3 0o( )cos j 0o( )sin+( )⋅+ +[⋅

1
3
--- UP1 UP2 UP3+ +[ ]⋅

=

=

=

=

Ια

Ιβ

Ιγ

1
3
---

1 e
j2π

3
-------

e
j4π

3
-------

1 e
j4π

3
-------

e
j2π

3
-------

1 1 1

ΙP1

ΙP2

ΙP3

⋅ ⋅ 1
3
---

1 ej 120°⋅ ej 240°⋅

1 ej 240°⋅ ej 120°⋅

1 1 1

ΙP1

ΙP2

ΙP3

⋅ ⋅= =

Ια
1
3
--- ΙP1 ej 0o ϕ±( ) ej0o⋅ ⋅ ΙP2 e j– 120o ϕ±( ) ej120o⋅ ⋅ ΙP3 e j– 240o ϕ±( ) ej240o⋅ ⋅+ +[ ]⋅

1
3
--- ΙP1 ej 0o ϕ±( ) j0o+⋅ ΙP2 e j 120o ϕ±( )– j120o+⋅ ΙP3 e j 240o ϕ±( )– j240o+⋅+ +[ ]⋅

1
3
--- ΙP1 0o ϕ± 0o+( )cos j 0o ϕ± 0o+( )sin+( )⋅

ΙP2 120o ϕ± 120o+–( )cos j 120o ϕ± 120o+–( )sin+( )⋅

ΙP3 240o ϕ± 240o+–( )cos j 240o ϕ± 240o+–( )sin+( )⋅

+

+

[

]

1
3
--- ΙP1 ϕ±( )cos j ϕ±( )sin+( )⋅ ΙP2 ϕ±( )cos j ϕ±( )sin+( )⋅ ΙP3 ϕ±( )cos j ϕ±( )sin+( )⋅+ +[⋅=

⋅=

=

=
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A Formulas and Algorithms
Negative sequence 
system: 

Voltage

From this, the following relation is derived for Uβ:

Current

From this, the following relation is derived for Ιβ:

Uα

Uβ

Uγ

1
3
---

1 e
j2π

3
-------

e
j4π

3
-------

1 e
j4π

3
-------

e
j2π

3
-------

1 1 1

UP1

UP2

UP3

⋅ ⋅ 1
3
---

1 ej 120°⋅ ej 240°⋅

1 ej 240°⋅ ej 120°⋅

1 1 1

UP1

UP2

UP3

⋅ ⋅= =

Uβ
1
3
--- UP1 ej0o ej0o⋅ ⋅ UP2 e j– 120o ej240o⋅ ⋅ UP3 e j– 240o ej120o⋅ ⋅+ +[ ]⋅=

Ια

Ιβ

Ιγ

1
3
---

1 e
j2π

3
-------

e
j4π

3
-------

1 e
j4π

3
-------

e
j2π

3
-------

1 1 1

ΙP1

ΙP2

ΙP3

⋅ ⋅ 1
3
---

1 ej 120°⋅ ej 240°⋅

1 ej 240°⋅ ej 120°⋅

1 1 1

ΙP1

ΙP2

ΙP3

⋅ ⋅= =

Ιβ
1
3
--- ΙP1 ej 0° ϕ±( ) ej0°⋅ ⋅ ΙP2 ej 120° ϕ±( ) ej240°⋅ ⋅ ΙP3 ej 240° ϕ±( ) ej120°⋅ ⋅+ +[ ]⋅

1
3
--- ΙP1 ej 0° ϕ±( ) 0°+( )⋅ ΙP2 e j–( ) 120° ϕ±( ) j120°+⋅ ΙP3 e j–( ) 240° ϕ±( ) j240°+⋅+ +[ ]⋅

1
3
--- ΙP1[ 0° ϕ± 0°+( )cos( j 0° ϕ± 0° )+( )sin

ΙP2 120°– ϕ± 240°+( )cos(⋅ j 120°– ϕ± 240° )+( )sin+

ΙP3 240°– ϕ± 120°+( )cos(⋅ j 240°–( ϕ± 120° ) ) ]

1
3
--- ΙP1[ 120°– ϕ±( )cos j 120°– ϕ±( )sin+( )⋅ ⋅ ΙP2 120°– ϕ±( )cos j 120°–( ϕ )±sin+( )⋅+=

+sin+

+

+

+

⋅ ⋅

ΙP3 120°– ϕ±( )cos j 120°– ϕ±( )sin+( ) ]⋅+

=

=

=
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A.5 Flicker
A.5 Flicker 

Flicker is a measure of voltage fluctuations in the low voltage distribution.

In calculating the Flicker parameter, you obtain evaluation indicators that 
indicate the effects of the flicker: 

Pst and Plt are a measure of the interference effect

Ast and Alt are a measure of the interference sensitivity.

The abbreviation st stands for short term, lt for long term.

Short-term:

and

Long-term:

and 

Caution:

For flicker calculations, you do not have to define averaging times, 
because the calculation algorithm for the parameter Flicker defines that 
Pst or Ast is calculated every 10 minutes and Plt or Alt every 120 minutes.

Pst 0 0314. P0 1.⋅ 0 0525. P1s⋅ 0 0657. P3s⋅ 0 28. P10s⋅ 0 08. P50s⋅+ + + +( )=

Ast P3
st=

Note:

The flicker calculation is based on the 250 V lamp model.

Plt
Pstj

3

12
------------

j 1=

12

∑
 
 
 
 

3=

Alt P3
lt=
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A Formulas and Algorithms
A.6 Harmonics of the voltages and currents 

SIMEAS Q measures the harmonics up to the 40th order.

The harmonic components are determined by a Fast-Fourier analysis of 
the sampled signals (according to IEC 61000-4-7). The amplitude of the 
fundamental and the harmonics up to the 40th order are calculated for 
each current and voltage input. The number of harmonics is defined user-
specifically during parameterization. For voltages, the device determines 
the amplitude values as a ratio to the fundamental as a percentage 
because of the nominal voltage value. The harmonic currents are meas-
ured directly in amperes.

THD The THD factor (Total Harmonic Distortion) is the RMS value of all har-
monics divided by the RMS value of the fundamental of the voltage. 

Voltage

where

n Order of the harmonic

U RMS value of the voltage

THD 0 01.
U1

------------ U2
n

n 2=

40

∑=
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A.7 Energy (only for continuous recording)
A.7 Energy (only for continuous recording) 

Electrical energy is defined as the power over a certain period. 
SIMEAS Q uses the set averaging time here.  

Active energy EP

Input To calculate the active energy in the input direction, the device integrates 
the positive active power values over the set averaging time.

Output To calculate the active energy in the output direction, the device inte-
grates the negative active power values over the set averaging time.

Caution:

To obtain the correct sign in the following calculations, SIMEAS Q must 
be connected in phase and with the correct direction of power flow.

EP input– Ptotal pos,∑=

where:

Ptotal pos,
0 Ptotal 0≤∧

Ptotal Ptotal 0>∧






=

EP output– Ptotal neg,∑=

where:

Ptotal neg,
0 Ptotal 0>∧

P– total Ptotal 0≤∧






=
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A Formulas and Algorithms
Reactive energy EQ

Capacitive To calculate the capacitive reactive energy, the positive reactive power 
values are integrated over the set averaging time; for inductive reactive 
energy, the negative reactive power values.

Inductive To calculate the inductive reactive energy, the negative reactive power 
values are integrated over the set averaging time.

Apparent energy ES To calculate the apparent energy output, SIMEAS Q integrates the 
apparent power values over the set averaging time.

EQ Cap– Qtotal pos,∑=

where:

Qtotal pos,
0 Qtotal 0≤∧

Qtotal Qtotal 0>∧






=

EQ Ind– Qtotal neg,∑=

where:

Qtotal neg,
0 Qtotal 0>∧

Q– total Qtotal 0≤∧






=

ES Stotal∑=
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Averaging Times, Time Bases, 
Threshold Values B
Overview To acquire energy values, defined periods are required. If you want sys-

tem messages to be derived from energy values, the corresponding 
threshold values must be defined. SIMEAS Q Parameterization uses the 
terms averaging time, time base, and threshold value.

In this appendix, the terms are uniquely defined and value ranges are 
listed in a table for the individual parameters of the various recording 
modes.

Contents B.1  Term definitions  110

B.2  Averaging times and time bases (continuous recording)  111

B.3  Averaging times and thresholds (fault value measurement)  113
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B Averaging Times, Time Bases, Threshold Values
B.1 Term definitions

Averaging time The averaging time defines the period over which the arithmetic mean is 
calculated from the acquired measured values. 

Depending on the recording mode, SIMEAS Q processes this mean 
value in different ways:

During continuous measurement, the mean value is stored together with 
the time stamp End of measuring period. 

For measurement in the event of a fault, SIMEAS Q compares the mean 
value with one or more thresholds. The device only stores if at least one 
upper or lower threshold has been exceeded.

Time base The time base is only required for continuous recording. It is the period 
over which a measured value is formed from the digitized analog value. 
A largest and a smallest value is filtered out of these measured values to 
determine the extreme values of a measured quantity within the averag-
ing time.

Threshold value Threshold values are user-specifically parameterized limit values for 
acquisition in the event of a fault. The system requires at least one 
threshold value for each measured quantity. A measured quantity is only 
acquired if at least one upper or lower threshold value is exceeded.
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B.2 Averaging times and time bases (continuous recording)
B.2 Averaging times and time bases (continuous recording)

If you parameterize SIMEAS Q for continuous recording of measured 
values, you can select different averaging times for the measured quan-
tities. The system requires the time bases to acquire extreme values. 

Table B-1 Averaging times and time bases with reference to the measured quantity for continuous 
recording

Measured value Averaging times Time bases for extreme value 
acquisition

RMS values phase-ground 
voltages or phase-phase 

voltages

1, 2, 5, 6, 10, 15, 30 s
1, 2, 5, 6, 10, 15, 30, 60 min

for 50 Hz nominal frequency
20, 40, 60, 80, 100, 120, 140, 
160, 180, 200, 500 ms,
1, 2, 5, 6, 10, 15, 30 s
1 min

for 60 Hz nominal frequency
16, 33, 50, 66, 83, 100, 116, 
133, 150, 166, 183, 200, 
500 ms,
1, 2, 5, 6, 10, 15, 30 s,
1 min

RMS value phase currents

Nominal frequency 1, 2, 5, 6, 10, 15, 30 s
1 min

Active power 
(per phase and total)

Reactive power 
(per phase and total)

Apparent power 
(per phase and total)

Power factor 
(per phase and total)

Balance current and 
voltage

Flicker interference factor 
short-term

10 min

Flicker interference factor 
long-term

120 min
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B Averaging Times, Time Bases, Threshold Values
1st to 40th harmonic 
voltage per phase

1, 2, 5, 6, 10, 15, 30 s
1, 2, 5, 6, 10, 15, 30, 60 min

1, 2, 5, 6, 10, 15, 30 s
1 min

1st to 40th harmonic 
current per phase

Total harmonic distortion 
THD per phase

Active energy - input
Active energy - output

Reactive energy - 
inductive

Reactive energy - 
capacitive

Apparent energy

1, 2, 5, 6, 10, 15, 30, 60 min

Table B-1 Averaging times and time bases with reference to the measured quantity for continuous 
recording

Measured value Averaging times Time bases for extreme value 
acquisition
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B.3 Averaging times and thresholds (fault value measurement)
B.3 Averaging times and thresholds (fault value measurement)

The averaging times for measurements in the event of a fault are deter-
mined independently of the averaging times for continuous recording. In 
addition, at least one threshold value must be defined for each measured 
quantity.

Table B-2 Averaging times and threshold values for recording in the event of 
a fault

Measured value Averaging times Number 
of thres-

holds

RMS values 
phase-ground voltages 

or 
phase-phase voltages 

for 50 Hz nominal frequency
10, 20, 50, 100, 500 ms,
1, 2, 5, 6, 10, 15, 30 s,
1, 2, 5, 6, 10, 15, 30, 60 min

for 60 Hz nominal frequency
8, 16, 33, 50, 66, 83, 100, 
116, 133, 150, 166, 183, 
200, 500 ms,
1, 2, 5, 6, 10, 15, 30 s,
1, 2, 5, 6, 10, 15, 30, 60 min

5

RMS value phase 
currents

Nominal frequency 1, 2, 5, 6, 10, 15, 30 s
1, 2, 5, 6, 10, 15, 30, 60 min

2

Active power 
(per phase and total)

Reactive power 
(per phase and total)

Apparent power 
(per phase and total)

Power factor 
(per phase and total)

Balance current and 
voltage

5

113SICARO Q Manager Manual
E50417-H1076-C111-A4

http://siemens-russia.com/


B Averaging Times, Time Bases, Threshold Values
1st to 40th harmonic 
voltage per phase

1, 2, 5, 6, 10, 15, 30 s
1, 2, 5, 6, 10, 15, 30, 60 min

2 per 
harmonic

1st to 40th harmonic 
current per phase

Total harmonic distortion 
THD per phase

2

Table B-2 Averaging times and threshold values for recording in the event of 
a fault

Measured value Averaging times Number 
of thres-

holds
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Glossary 

Averaging time The averaging time is a multiple of the → Time base. Over the period of 
the averaging time extreme values are formed.

Balanced net Polyphase system, in which all phases are stressed equally with           
consumers.

Time base Period of time during which an mean value is formed from the sampled 
values. These mean values are used for the forming of extreme values 
during the period of the → Averaging time. The averaging time should be 
an integer multiple of the time base.

Binary outputs Output of binary signals (high and low) for the switching of relays.

Byte Information unit consisting of 8 bits.

Classical 
method

Algorithm for the power calculation in a → Balanced net, not taking the 
harmonics into consideration.

Continuous 
recording

Continuous recording of measured variables in a time base which is to be 
determined specifically by the user.

Converter Adapter for the connection of various standard interfaces.

Expanded method Algorithm for the power calculation in an → Unbalanced net, taking the 
harmonics into consideration.

Fault recording Only measured variables which exceed the → Threshold values        
specified by the user, are saved with time stamp.

Flicker Measure for voltage fluctuations in the low voltage distribution.

FT File Transfer

GSD file Geräte Spezifische Datei (Device-specific-file)
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Glossary
Master Higher-level device which monitors and controls sub-devices (→ slave).

Navigation window Displays the program structure of the measurement settings. Through 
single clicks or double clicks on the structure icons, you can navigate 
between the various parameter sets and dialog windows.

Negative-sequence 
system

Polyphase system in which the phases L1, L2 and L3 are each by 120° 
out of phase counterclockwise.

Positive-sequence 
system

Polyphase system, in which the phases L1, L2 and L3 are each by 120° 
out of phase clockwise.

Pst, Plt Measure for the interference effect (short term; long term) of voltage fluc-
tuations.

SD file Extension of the parameter files 

SICARO Q Manager 
V2.30

Software product SICARO Q Manager V2.30 for SIMEAS Q

SIMEAS Q SIemens MEAsuring Systems Quality

Network Quality Recorder

SIMEAS Q 
Parameterization

Parameterization software for SIMEAS Q

Slave Sub-device which is monitored and controlled by a higher-level device 
(→ Master).

Standard
parameter set

Ex-works preset parameter file set in SIMEAS Q and in the SIMEAS Q 
parameterization.

SU Reversing of summer time and winter time

THD Total harmonic distortion

Threshold Limiting value which triggers off an event, e.g. status signal, warning, dis-
connection etc. Several threshold values which trigger off classified 
events, can be determined for each measured variable.

Time information Date and time of an event 
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Glossary
Time stamp → Time information 

Unbalanced net Polyphase system in which not all phases are stressed equally with    
consumers.
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Index

Numerics
3 wire network - Delta 35
4 wire network - Star 35
4 wire network- Star 35

A
Activating measured variables for continuous
measuring 44
Activating measured variables for fault re-
cording 47
Active power input/output 38
Active/reactive/Apparent energy export per
pulse (kVA) 38
Add

Display element 78
Add display element 78, 80
Algorithm

nominal frequency 97
Algorithms 95

2-wattmeter method 99
3-wattmeter method 100
balanced systems 101
current 96
energy 107
Flicker 105
harmonics 106
negative sequence system 104
power classic 98
power modern 101
THD 106
total harmonic distortion 106
unbalanced systems 102
voltage 96

Archive
Configure 67
Continuous 65
In the cyclic storage mode 65

Archive part
Creating 67
Deleting 69

Archive statistics
Printing 71
View 70

Archiving
Measured data 64

Arrange
Display elements 81

Averaging time
fault value measurement 113
recording continuous 111

Averaging times 109
definition 110

B
Basic settings 34
Basic time 42
Beenden 20
Binary output

Presetting 37
Binary output 1 37
Binary output 2 37
Binary outputs 37

Functions 37
Board number 24
Buffer overflow 30

C
Calling the identification of the SIMEAS Q de-
vices 27
Changing display element properties 83
Changing the language 11
classical 41
Commands 56
Commands context menu 56
Configure 31

Measurement settings 7
Configure properties for data transfer 74
Configuring measurement settings 33
Continuous archive 65
Continuous recording 44

averaging time 111
Select measured variables 44
time base 111

Controlling measured data recording 53
CP5411, CP5411 (PCMCIA) or CP5611 com-
munications modules 9
CP5412 (A2) communications module 9
Current

formulas 96
Cyclic storage archive 65
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Index
D
Data

Export 87
Data sheets 33
Data window 33
Default

Network settings 35
Delete

Display element 82
Device

Remove 19
Rename 17

Device address 27
Direct connection 23, 24
directly 41
Display 78

calling 77
Create 78

Display element
Save layout 82

Display file 89
Displaying measured data 75

E
Energy

formulas 107
Enter threshold 48
Enter threshold value 48
expanded 41

F
Fault recording

Selecting measured variables 47
Fault value measurement

averaging time 113
threshold values 113

Firmware version 27
Flicker 41

formulas 105
Flicker long term 45
Flicker short term 45
Formulas 95

2-wattmeter method 99
3-wattmeter method 100
balanced systems 101
classic power 98
current 96
energy 107
Flicker 105
harmonics 106
negative sequence system 104
nominal frequency 97
power modern 101

THD 106
total harmonic distortion 106
unbalanced systems 102
voltage 96

from or from...to 41
Function of the two relay outputs 34
Functions Binary outputs 37
Functions of the Program 12

Create new project 12
Open project 12
Print project 12
Save project 12
Start data transfer 12

H
Harmonics

formulas 106

I
Interval 74

K
Knoten 18
Kompatibilität 2

L
Latest calibration date 27

M
Manufacturing number 27
Measured data

Archiving 64
Measurement active 48
Measurement settings 31, 33

Basic settings 33
Continuous recording 33
Recording in events of faults 33

Messages (indications)
View 72

Modem connection 23, 25

N
Navigation window 33
Network frequency 27
Network settings 34, 35

Default 35
Network type 34
No connection 23
Node

Remove 20
Nominal frequency 28, 34

formulas 97
Nominal voltage 34
Number of possible entries 30
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Index
Number of used entries for continuous mea-
surement 30

O
Open 32
Order number 27
Other settings 34, 39

Basic time 42
Flicker 41
Power calculation 41
Presetting 40
Save mode 42
Start of recording and period of recording

41

P
Parameterizing the measurement settings 31
Power

2-wattmeter method 99
3-wattmeter method 100
balanced systems 101
classic calculation 98
modern calculation 101
negative sequence system 104
unbalanced systems 102

Power calculation 41
Presetting

Binary outputs 37
Presettings 37

Other 40
Printing the project data 50
PROFIBUS DP 23
PROFIBUS DP connection type 24
Programm

beenden 20
Projekt

öffnen 21
speichern 20

R
Receive 31
Receive device status 29
Receive identification 27
Recording

Control 53
Recording capacity 30
Recording for period 29
Recording in event of faults 47
Recording in events of faults 33
Recording in the event of faults 38
Recording not running 30
Recording running 30
Recording started 29

Removing a node 20
Requirements for the Hardware 5
Requirements for the Software 4

S
Save 32
Save as 32
Save mode 42
Select measured variable 79
Select measured variables 44
Selecting measured variables 44, 47

Fault recording 47
Selecting the connection type 23
Selecting the device connection 22
Send 32
Sending date/time of day (Set SIMEAS Q
clock) 51
Setting the cycle times for the data transfer
74
SICARO Q Manager

Calling the 10
SIMEAS Q active 37
SIMEAS Q commands 53
SIMEAS Q Parameterization

Introduction 1
SIMEAS Q restart - special function 56
Single-phase system 35
Specifying basic settings 34
Specifying measurement settings 31
Specifying the date and time of day in SIME-
AS Q devices 51
Specifying the device address 23
Specifying the time of day for all SIMEAS Q
devices 51
Specifying the time of day for an individual
SIMEAS Q device 52
Speichern 20
Start of recording and period of recording 41
Start recording 53
Start recording for period 53
Start recording with start time... 53
Start time 74
Start/End of recording and period of record-
ing 41
State of measured- value buffer 30
State of the measurement 30
Stop recording 53
Stop recording and clear memory 53
Stopping the data transfer 86

T
THD

formulas 106
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Index
Threshold value cosj 38
threshold value for harmonics 47
Threshold values 109

definition 110
fault value measurement 113

Time base
recording continuous 111

Time bases 109
definition 110

Total harmonic distortion
formulas 106

Transformer ratio of the primary voltage/cur-
rent transformers 34
Type of measurement 29

U
Untitled standard data set 33
user interface of SICARO Q Manager 11
user interface of the SICARO Q Manager
software 11

V
Verbindung

prüfen 26
Voltage

formulas 96
Voltage dip 38

Y
Yes, with MIN/MAX 45
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To

Siemens AG

PTD EA D SC22

Postbox 4806

D-90026 Nuremberg

From:

Your name : ................................................................................................

Your title : ................................................................................................

Yourcompany : ................................................................................................

Department : ................................................................................................

Street : ................................................................................................

City, State : ................................................................................................

Phone : ................................................................................................

Fax : ................................................................................................

Please tick your area of work:

Other

Automation

Mining (incl. strip mining)

Chemical industry

Power generation

Power distribution, power system 
management

Gas/water/sanitary utilities

Building services, air conditioning

Heavy machine construction, 
handling systems

Pipelines

Shipbuilding, navigation

Environmental technology

Traffic and transportation
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Remarks/Suggestions

Your remarks and suggestions will help us to enhance the usability of our 

documentation. Please fill in this questionnaire and mail or fax it back to Siemens 

(fax number +49-911-433-8518).

Title of the Manual: SICARO Q Manager

Order No. of the Manual: E50417-H1076-C111-A4
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1 = good 5 = poor.

1. Does the contents cover your requirements? ...........

2. Could you spot the information you need without any problems? ...........

3. Did you find the texts easy to understand? ...........

4. Does the information depth meet your requirements? ...........

5. How do you judge the quality of the illustrations? ...........

If you have encountered any concrete problems, please give us a concise 

description:
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............................................................................................................................

............................................................................................................................

............................................................................................................................
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